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Notice
Every effort was made to ensure that the information in this document was accurate at 
the time of printing. However, information is subject to change without notice, and Viavi 
reserves the right to provide an addendum to this document with information not avail-
able at the time that this document was created.

Copyright 
© Copyright 2018 Viavi, LLC. All rights reserved. Viavi, Enabling Broadband and Optical 
Innovation, and its logo are trademarks of Viavi, LLC. All other trademarks and regis-
tered trademarks are the property of their respective owners. No part of this guide may 
be reproduced or transmitted electronically or otherwise without written permission of 
the publisher.

Trademarks
Viavi and SmartOTDR are trademarks or registered trademarks of Viavi in the United 
States and/or other countries.

Microsoft, Windows and Microsoft Internet Explorer are either trademarks or registered 
trademarks of Microsoft Corporation in the United States and/or other countries.

Specifications, terms, and conditions are subject to change without notice. All trade-
marks and registered trademarks are the property of their respective companies.

WEEE Directive Compliance
Viavi has established processes in compliance with the Waste Electrical and Electronic 
Equipment (WEEE) Directive, 2002/96/EC, and the Battery Directive, 2006/66/EC.

This product, and the batteries used to power the product, should not be disposed of as 
unsorted municipal waste and should be collected separately and disposed of according 
to your national regulations. In the European Union, all equipment and batteries 
purchased from Viavi after 2005-08-13 can be returned for disposal at the end of its 
useful life. Viavi will ensure that all waste equipment and batteries returned are reused, 
recycled, or disposed of in an environmentally friendly manner, and in compliance with 
all applicable national and international waste legislation.
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It is the responsibility of the equipment owner to return equipment and batteries to Viavi 
for appropriate disposal. If the equipment or battery was imported by a reseller whose 
name or logo is marked on the equipment or battery, then the owner should return the 
equipment or battery directly to the reseller.

Instructions for returning waste equipment and batteries to Viavi can be found in the 
Environmental section of Viavi’s web site at www.viavisolutions.com. If you have ques-
tions concerning disposal of your equipment or batteries, contact Viavi’s WEEE Program 
Management team.
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About This Guide

The SmartOTDR of Viavi provides a handheld OTDR designed for the construction, turn-
up and maintenance of fiber networks.

The topics discussed in this chapter are as follows:

• “Purpose and scope” on page xvi

• “Assumptions” on page xvi

• “Technical assistance” on page xvi

• “Conventions” on page xvi



About This Guide
Purpose and scope

xvi User Manual 7SMART102 Rev004

Purpose and scope
The purpose of this guide is to help you successfully use the SmartOTDR features and 
capabilities. This guide includes task-based instructions that describe how to install, 
configure, use, and troubleshoot the SmartOTDR. 

Additionally, this guide provides a complete description of Viavi’s warranty, services, and 
repair information, including terms and conditions of the licensing agreement.

Assumptions
This guide is intended for novice, intermediate, and experienced users who want to use 
the SmartOTDR effectively and efficiently. We are assuming that you have basic 
computer and mouse/track ball experience and are familiar with basic telecommunica-
tion concepts and terminology.

Technical assistance 
If you require technical assistance, call 1-844-GO-VIAVI. For the latest TAC information, 
go to http://www.viavisolutions.com/en/services-and-support/support/technical-assis-
tance.

Conventions
This guide uses naming conventions and symbols, as described in the following tables.

Table 1 Typographical conventions

Description Example

User interface actions appear in this 
typeface.

On the Status bar, click Start.

Buttons or switches that you press on a 
unit appear in this TYPEFACE.

Press the ON switch.

http://www.viavisolutions.com/en/services-and-support/support/technical-assistance
http://www.viavisolutions.com/en/services-and-support/support/technical-assistance
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Table 3 Symbol conventions

Code and output messages appear in 
this typeface.

All results okay

Text you must type exactly as shown 
appears in this typeface.

Type: a:\set.exe in the dialog box

Variables appear in this typeface. Type the new hostname

Book references appear in this typeface. Refer to Newton’s Telecom Dictionary

A vertical bar | means “or”: only one 
option can appear in a single command.

platform [a|b|e]

Square brackets [ ] indicate an optional 
argument.

login [platform name]

Slanted brackets < > group required 
arguments.

<password>

Table 2 Keyboard and menu conventions 

Description Example

A plus sign +  indicates simultaneous 
keystrokes.

Press Ctrl+s

A comma indicates consecutive key 
strokes.

Press Alt+f,s

A slanted bracket indicates choosing a 
submenu from menu.

On the menu bar, click 
Start > Program Files.

This symbol represents a general hazard.

This symbol represents a risk of electrical shock.

Table 1 Typographical conventions

Description Example
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Table 4 Safety definitions

NOTE

This symbol represents a Note indicating related information or tip.

This symbol, located on the equipment or its packaging indicates that 
the equipment must not be disposed of in a land-fill site or as municipal 
waste, and should be disposed of according to your national regula-
tions.

WARNING

Indicates a potentially hazardous situation which, if not avoided, could result 
in death or serious injury.

CAUTION

Indicates a potentially hazardous situation which, if not avoided, may result 
in minor or moderate injury.
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Chapter 1Safety information

This chapter gives the main information on the safety conditions when using the Smar-
tOTDR:

• “Battery and AC/DC safety information” on page 2

• “Precautions relating to optical connections” on page 3

• “Laser Safety instructions” on page 3
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Battery and AC/DC safety information
Li-Polymer battery

• The Li-Polymer battery is designed for maximum safety.

In particular, each cell is provided with a safety valve to prevent excessive internal pres-
sure in the event of overcharging or exposure to very high temperatures.

AA Dry Battery Pack

Explosion danger

• Short-circuiting the batteries can result in overheating, explosion or ignition of the 
batteries and their surroundings.

• Never short-circuit the battery contacts by touching both contacts simultaneously 
with an electrical conducting object.

• Only use AA size dry batteries or rechargeable batteries.

• Make sure the batteries are inserted with the correct polarity.

• Battery supplied by Viavi incorporate protection means.

General precautions

• Do not use any mains adaptor or battery other than those supplied with the instru-
ment, or supplied by Viavi as an option for this instrument.

If another adapter or battery is used, it may damage the SmartOTDR itself.
Using the SmartOTDR with a battery other than the one supplied by the manufac-
turer of the SmartOTDR may entail risks of fire or explosion. 

The battery may explode, leak or catch fire:

– if it is exposed to high temperature or fire

– if it is opened or dismantled.

• If you do not intend to use the platform for several weeks, it is advisable to 
remove the battery in order to prolong its useful life, and to recharge it fully before 
using it again.

• In case of communication problems with the battery, informed to the user, the 
battery charging information is no more actualized.
Restart the equipment to restore the communication with battery.
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Other basic safety precautions are as follows:

• Do not use AC/Adapter/Charger outdoors or in wet or damp locations

• Connect the AC/Adapter/Charger to the correct mains voltage, as indicated on 
the ratings label.

• Do not allow anything to rest on the power cord, and do not locate the product 
where people can walk on the power cord.

• Avoid using this product during an electrical storm. There may be a remote risk of 
electric chock from lightning.

• Do not use this product in the vicinity of a gas leak or in any explosive environ-
ment.

• Do not attempt to service this product yourself, as opening or removing covers 
may expose you to dangerous, high voltage points and other hazards. Contact 
qualified service personnel for all service.

Precautions relating to optical connections
• The normal operating life of an optical connector is usually of the order of a few 

hundred manipulations. It is then advisable to manipulate the optical connections 
of the Platform as rarely as possible.

• The proper operation of the instrument and its accuracy of measurement are 
dependent on the cleanliness of the environment and the optical connectors as 
well as the care taken in its manipulation.

• The optical connectors must therefore be clean and dust-free. If the optical 
connection is not being used, protect the connections of SmartOTDR using the 
protective caps.

As an example, the results of measurements made with connectors that have not been 
cleaned will display an error of the order of 10% for all measurements. This error is addi-
tional to other errors inherent in the measurement process and due, for example, to the 
quality of the fiber (circularity and concentricity), the means of connection (axis align-
ment, distance between fiber faces, quality of fiber faces) and propagation modes.

Laser Safety instructions
The provisions contained in two standards define the safety procedures to be observed 
both by users and by manufacturers when utilizing laser products:

• EN 60825-1: 2001 - Safety of laser products – Part 1: Classification of products, 
requirements and user guidelines. 
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• FDA 21 CFR § 1040.10 - Performance standards for light-emitting products - 
Laser products.

Due to the range of possible wavelengths, power values and injection characteristics of 
a laser beam, the risks inherent in its usage vary. The laser classes form groups repre-
senting different safety thresholds.

Laser classes
Standards EN 60825-1, Edition 1.2, 2001-08 and FDA21CFR§1040.10: 

• VFL option: Class 2.

Warning labels for the laser classes 
Due to the reduced dimensions of the optical modules, it is not possible to attach the 
required warning labels to them. In line with the provisions of Article 5.1 of the EN 60825-
1 standard, the laser class identification labels are shown below:

The user must take the necessary precautions concerning the optical output of the 
instrument and follow the manufacturer’s instructions.

Reference standard EN 60825-1, Edition 1.2, 2001-08 FDA21CFR§1040.10

Class 1

Class 1M

Class 2

Measurements on optical fibers are difficult to execute and the preci-
sion of the results obtained depends largely on the precautions taken 
by the user.

CLASS 1
LASER PRODUCT
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Chapter 2Introducing the SmartOTDR

This chapter provides a general description of the SmartOTDR.

Topics discussed in this chapter include the following: 

• “Unpacking the instrument” on page 6

• “Main features” on page 6

• “Hard keys and Indicators” on page 9

• “Power Supply” on page 11
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Unpacking the instrument
1 Remove the SmartOTDR and its accessories from the packing case.

2 Check that the correct model and accessories ordered are all there.

If any part is missing or damaged please contact your local Viavi agent.

The SmartOTDR is delivered as standard with:

Main features
The SmartOTDR is equipped with the following elements:

• A 5 inch color capacitive touchscreen, high visibility

• Two USB 2.0 host connectors for Microscope, USB memory stick, mouse, 
keyboard...

• One mini USB 2.0 device connector to connect the SmartOTDR to a PC

• A connection socket for the mains adapter providing the 15 V power supply and 
used to charge the battery.

• LED indicators for Charge, On status and Test

• A Li-Polymer battery or AA dry battery pack

• Built-in VFL (option)

With the SmartOTDR, the user can:

• Open and/or transfer files to a PC via a USB memory stick, USB cable or Wire-
less connectivity

• Generate pdf reports

Table 5 Elements delivered on standard with the SmartOTDR

A Getting Started Manual

A Li-Polymer battery, set into the equipment and which must be charged before use
 or
A AA dry battery pack

A mains adapter used for mains operation of the instrument and battery charging 

5 country adaptable plugs (Europe / UK / US / Australia / Japan)

A hands-free soft case for the SmartOTDR

A USB cable, to directly connect the SmartOTDR to a PC
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• Open all user documentations included into the SmartOTDR

• Update the SmartOTDR firmware

• Remote the screen of the SmartOTDR onto a PC and issue commands from the 
keyboard of the PC

• ...

Figure 1 SmartOTDR
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Figure 2 SmartOTDR: Front view

Hard keys
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Figure 3 SmartOTDR: Connectors View
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Hard keys and Indicators

Front panel hard keys

Figure 4 Hard keys and Indicators

Table 6 Hard keys description

Hard key Function

Main on/off switch

This button calls up the file explorer. It allows to:

• choose the storage medium: internal memory, USB memory key.

• manage files; with facilities for classifying them in directories and sub-directories

Gives access to:
• selection of the different measurement or functions
• the settings of the instrument
• the help page

This button calls up the measurement configuration menu. This menu depends 
on the function in use.

This button allows to deselect a function or escape a menu

Starts and stops the measurement.

This button calls up the results page (e.g. with OTDR module: reflectometry 
trace and table of results).
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The direction keys have two principal functions:

Front panel indicators
The SmartOTDR is equipped with three indicators, lit into a different color according to 
the status of the unit.

• on the Results page, they are used to move the cursors or modify 
the zoom factor.

• on the set-up pages, they are used to scroll through the menus, the 
central button serving to select or confirm the parameter chosen.

Table 7 Indicators Status

On indicator

 Blinking 
green

The instrument, though connected to an external power 
source, is switched off.

Solid green
The instrument is operating, either by battery or on an 
external power supply.

Charge indicator

Solid green
The instrument is connected to an external power source 
and the battery is fully charged.

Solid red
The instrument is connected to an external power source, 
and the battery is on charge.

Testing indicator

Solid red
At least one function is in measurement phase (for exam-
ple, the laser emission pilot for an OTDR measurement)
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Power Supply
The SmartOTDR may operate with

• the Li-Polymer battery or the AA dry battery pack (according to what has been 
ordered) or a AA dry battery pack (according to the order placed).

• an AC adapter/charger, via a power cable on which has been set the correct 
country adaptable plug.

Figure 5 Delivered elements for SmartOTDR supplying

Interchangeable plugs

Power supply plug

UK adaptable plug 
(installed by default)

EUROPE 
adaptable plug

US
adaptable plug

JAPAN
adaptable plug

AUSTRALIA
adaptable plug

INDIA
adaptable plug
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Chapter 3Starting up

This chapter describes the first steps to perform when using the SmartOTDR.

The topics discussed in this chapter are as follows:

• “Setting the adaptable plug to the mains adapter” on page 14

• “Charging the battery” on page 15

• “Switching the SmartOTDR on and off” on page 17

• “Choosing the position of the instrument on the work surface” on page 18

• “First start: configuring the regional settings” on page 19



Chapter 3 Starting up
Setting the adaptable plug to the mains adapter

14 User Manual 7SMART102 Rev004

Setting the adaptable plug to the mains adapter
The SmartOTDR is supplied as standard with a mains adapter and 5 country adaptable 
plugs (Europe / UK / US / Australia/Japan).

To set the correct plug to the mains adapter:

1 Make flush the connector onto the mains adapter with the adaptable plug slots.

2 Push the adaptable plug until it stops.

Figure 6 Setting the adaptable plug onto the mains adapter

1

2 3

If the adapter plug is not correctly set onto the mains adapter, the con-
nector may be damaged.
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Charging the battery

Connecting the mains adapter
1 Set the appropriate adaptable plug to the power supply cable, according to your 

country (see page 14).

2 At the right side of the SmartOTDR, lift up the power supply socket protector and 
plug in the mains adapter. 

3 Connect the adapter to the mains. 

The On indicator lamp starts to blink in green.

First use of the battery
At the delivery, the battery is already set into the equipment, but its charge level is not 
«recognized» by the equipment. 

Using a Li-Polymer battery, the icon  is displayed on the upper banner of the 
screen.

To get a valid indication of the battery, and be able to use correctly the Platform:

1 Charge fully the battery

2 Once fully charged, discharge the battery by keeping the Platform switched on, 
but not plugged to mains.

3 The battery can then be charged, and the Platform used simultaneously.

CAUTION

Upon reception of the product, the battery of the SmartOTDR needs to 
be fully recharged, no later than 6 months after the date of calibration.

If the product is unused for a long period, the battery needs also to be 
periodically fully recharged, with a period not longer than 12 months

Use only the mains adapter supplied with the SmartOTDR. The adapter 
for some other electronic device may appear to be identical, but entails 
a risk of damage to the SmartOTDR.
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Charging the Li-Polymer battery
On connection to the mains:

• if the user does not press ON, the battery will start the charge. In this case, the 
Charge indicator will be lit in red. 

• when the user presses the ON key, the instrument starts up and the battery will 
charge during use (Charge indicator in solid red).

Once the battery is fully charged, the Charge indicator is lit in solid green.

When the Charge indicator is blinking red, this mean the power supply is not compatible 
with the battery used. Charge is disabled.

Battery charge level display
When the battery is installed in the instrument, a battery icon is displayed in the top right-
hand corner of the screen. Example: .

NOTE

If a AA Dry Battery pack is used, fully charge the batteries before setting the 
pack into the SmartOTDR.

It is essential to wait until charging is complete to ensure maximum 
independent operating time, which may otherwise be considerably 
reduced.

This icon is displayed exclusively when a Li-Polymer battery is 
installed into the equipment.

If a AA Dry Battery Pack is installed, then the icon displayed on the upper 
banner is , without charge level indication.

Table 8 Battery icons

The battery capacity is superior to 75%
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• When the level becomes too low, the instrument emits a beep ton inform the user 
until it switches off automatically after saving the current configuration and 
measurement.

Switching the SmartOTDR on and off

Switching on the SmartOTDR
1 Press the ON/OFF key.

If the equipment is powered to mains, the battery will charge.

The On indicator pass from blinking to solid green. 

The Viavi logo appears on the screen briefly, then an auto test is carried out.

The equipment is ready to be used once all the applications are installed.

The battery capacity is set between 50% and 75%

The battery capacity is set between 25% and 50%

The battery capacity is inferior to 25%

The battery capacity is unknown. Perform a full charge/discharge of the 
battery to get back to a valid indication.
This icon may appear if battery is changed or if the battery auto dis-
charges at a very low level (example: if a Platform switches off as bat-
tery is empty, and the charge is not done during several months (= auto 
discharge)).

Table 8 Battery icons

NOTE

It is possible to switch over from battery to mains operation, or vice versa, 
without loss of data.
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Switching off the SmartOTDR
While the SmartOTDR is operating, press the ON/OFF button to switch it off.

Resetting the SmartOTDR
If the SmartOTDR freezes, prolonged pressure (about 4 s.) on the ON/OFF key will reset 
the instrument.

Choosing the position of the instrument on the 
work surface

Depending on the conditions of use of the Platform 8000, the instrument may be placed 
on a flat surface or held in the hand.

When used on a work surface, the SmartOTDR should be supported on its stay, which 
can be set in either of two positions, depending on whether the user is standing or sitting.

To change the stay from “seated user” position to “standing user” position, pull the stand 
outside of its housing until the stop.

Push the stand to return to «seated user» position.

In the event of an unexpected mains power cut, if there is no battery, 
the current results and configuration will not be saved. Next time the 
instrument is switched on, it will return to its initial configuration.

NOTE

When the instrument is switched off using the ON/OFF button, current results 
and configuration are saved. Next time the ON/OFF key is pressed, they are 
recalled.
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First start: configuring the regional settings
Once the SmartOTDR is switched on, the first screen displayed allows to configure the 
regional settings.

Those settings will be kept in memory and automatically applied on the instrument each 
time it is restarted.

Figure 7 SmartOTDR «seated» and «standing» user positions

Stand

Pull to lift 
the stand

Figure 8 Regional Settings
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1 Click on Language and select the language to be used for the equipment.

2 Click on Date and enter the current date, using the numeric keypad displayed 
using the menu key Edit Number.

3 Click on Time and enter the current time, using the numeric keypad displayed 
using the menu key Edit Number.

Date and time are displayed on the upper right side of the screen.

4 Click on Date Time Format and configure the following parameters:

– Date format: select one of the option dd/mm/yy or mm/dd/yy.

– Time format: select one of the option 24 hour clock or 12 hour clock.

5 Once all parameters have been defined, press Exit menu key to return to System 
Settings page.
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Chapter 4Configuring the SmartOTDR 

This chapter describes the operations for configuring the instrument.

The topics discussed in this chapter are as follows:

• “Displaying the System Settings screen” on page 22

• “Defining the screen parameters of the SmartOTDR” on page 23

• “Defining the Automatic shutdown and the type of batteries” on page 24



Chapter 4 Configuring the SmartOTDR
Displaying the System Settings screen

22 User Manual 7SMART102 Rev004

Displaying the System Settings screen
To display the System Settings screen, you must:

1 Press the HOME hard key to reach the Home page.

2 Activate the Settings icon  to open the System Settings screen.

Figure 9 Home page

Figure 10 System Settings page

NOTE

If you are in the Regional Settings page, and you press Exit, then the Sys-
tem Settings page automatically displays.
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Defining the screen parameters of the SmartOTDR
In the System Settings page, the following parameters can be defined:

Backlight
1 Click on Backlight 

2 Define the backlight level of the screen, using the left and right direction keys, or 
clicking on Edit Number softkey and using the keypad displayed.

– Min backlight level: -5

– Max backlight level: +5

Contrast
1 Click on Contrast

2 Select the type of environment into which the instrument is used:

– Indoor: to be selected when the instrument is used inside 

– Outdoor: to be selected in order to optimize the readability of the screen for an 
outside use (see Figure 10 on page 22)

If the SmartOTDR is operating on battery or AA dry battery pack, it is 
advisable to choose a minimum lighting level, acceptable for the user, 
to keep endurance as long as possible.

Figure 11 Example of indoor contrast
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Screen Saver
Click on Screen Saver if you wish to activate a screen saver to the equipment, to extend 
the life of the battery/AA dry battery pack, in case the SmartOTDR is not used for some 
time.
Instead of the normal screen, a small animated picture of the SmartOTDR is displayed 
on the blackened screen. 

To configure the screen saver:

1 Click on Delay and select the time of inactivity before the screen saver starts: 
60s, 3 min, 5 min.

The parameter No deactivates the screen saver function.

Defining the Automatic shutdown and the type of 
batteries

Automatic shutdown
The automatic shutdown function switches off the SmartOTDR automatically if no oper-
ation has been performed and no key actuated for a period selected from this menu. 
Work in progress is automatically saved.

1 In the Utility box, click on Auto off parameter.

2 Choose a time after which the SmartOTDR will be switched off automatically, if no 
action has been done for that period: 5, 10 or 30 minutes.

Select No if the SmartOTDR must not be switched off, even if there is inactivity on the 
equipment.

The function for automatically switching off the SmartOTDR is avail-
able only on battery operation, to save the battery.
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Type of batteries
When a AA Dry battery pack is used to work on the SmartOTDR, the type of batteries 
can be defined on the System Settings page: either NiMH (rechargeable) batteries or 
Alkaline batteries.

This parameter displays automatically if a AA dry battery pack is installed into the equip-
ment.

To define the batteries type:

1 In the Utility box, click on Batteries type parameter.

2 Select the batteries type installed into the SmartOTDR: NiMH or Alkaline.

The type of batteries is displayed in the About > General page (see “Accessing 
to the SmartOTDR information” on page 133).

The icon  displays on the upper banner.

Figure 12 Batteries Type
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Chapter 5Optical options

A variety of built-in optical options are available when ordering. See references in 
Chapter 10 “Options and accessories”, for details.

The topics discussed in this chapter are as follows:

• “Connection to the power meter and VFL” on page 28

• “Using the Power meter via USB port” on page 28

• “VFL Function” on page 42

• “Storing and reloading results” on page 43

NOTE

The Source function is available on the OTDR port (non-filtered). Refer to 
the OTDR User Manual for a complete description of the Source function.
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Connection to the power meter and VFL

• USB power meter uses UPP-type adapter, which is compatible with different 
connectors (FC, SC...)

• OTDR power meter uses same adapter as OTDR (see OTDR User Manual)

Using the Power meter via USB port
The power meter function is an option chosen at the time of order.

To activate the function:

1 Press the HOME button

2 Activate the power meter icon of the Mainframe .

The effect of this action will to be to bring the power meter into use and to display 
the Results page for Power Meter.

Configuring the power meter
The configuration parameters can be accessed with the SETUP key.

Figure 13 Optical connectors

Power meter optical 
connection via OTDR 
port (see OTDR User 
Manual)

VFL Power meter optical connection via 
USB (see below)
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Configuring the alarm parameters
Alarm Activation of the Alarm function: any result below the lower threshold 

or above the upper threshold will be displayed in red on the Results 
page.

Min and max thresholds

Choice of lower and upper thresholds for each available wavelength, 
from -60 to +40 dBm (selected with the direction keys).

Configuring the Measurement parameters
In the Setup page, press Measur’t soft key (if one parameter is selected in the current 
screen, press Top Menu soft key to display the right menu keys and click on Measur’t) 

Figure 14 Configuration of power measurement

NOTE

To copy one value of the Lower or/and Upper threshold for all wavelengths, 
select the reference value and click on Update for All Wavel..

NOTE

A continuous push on direction keys increments the value by 10 dBm.
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Wavelength Select wavelength:
Auto: the wavelength of the input signal will be automatically 
detected and selected to perform the measurement:
1310, 1490, 1550, 1625 or 1650 nm: measurement performed 
at specified wavelength.

Beep on modulation Select if a sound must be heard when a modulation occurs (Yes 
/ No)

Unit Unit of power displayed:
Watt, dBm for displaying absolute power
dB for displaying a result relative to a reference (link loss)

Reference level If dB units were chosen in the previous line, selection of the 
reference value for the wavelength selected. Using the direction 
keys, first choose the wavelength, then press the > key to 
access choice of the value (+XXX.XX), then confirm this value 
with the ENTER key.This reference is also automatically 
available, in the Results page, using the Set as Reference key.

Attenuator compensation
Choice of level to be applied to the wavelength chosen for 
measurement to compensate for the loss due to the external 
attenuator (+XX.XX dB). First use the direction keys to choose 

the wavelength, then press  to access choice of value, then 

confirm this value pressing ENTER.

Configuring the Link parameters
In the Setup page, press Link soft key (if one parameter is selected in the current 
screen, press Top Menu soft key to display the right menu keys and click on Link).

NOTE

Using MP 60 or MP80 power meter, set manually to Auto the Lambda to auto-
matically detect the wavelength: in results page, press Power Config. > 
Wavelength key multiple times until Auto is displayed.

NOTE

To copy a Reference Level/Attenuator Compensator on all wavelengths, 
select the reference wavelength and click on Update for All Wavel..
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The information entered in the Link window concerns the editing and/or the modifica-
tions of the cable and fiber parameters. When a trace is recalled without recall of the 
configuration, the parameters of this trace will be present only in its signature.

Link Description

Fiber ID
Select the parameter Fiber Id and enter a name for the fiber, using the edition keypad.

Fiber Number
Select the parameter Fiber Number and modify the parameter using the left and right 
direction keys.

The fiber number can be automatically incremented/decremented at each new 
file save if it has been configured in the following parameter.

Change Fiber Nbr

Increment the fiber number is automatically incremented at each new file-save.

Decrement the fiber number is automatically decremented at each new file-save

User defined Use Edit Number softkey to enter the increment/decrement value for 
fiber number.

Note: to decrement the number, enter the sign «-» before the number. 
Example: -1.

NOTE

The softkey Copy File/Link To all is displayed when one parameter is 
selected in the Link or File Setup page and when the Powermeter function is 
active at the same time as another FO application (for example OTDR 
Expert). 

It allows to apply the Link and File configuration parameters of the current 
applications to all the other active Fiber Optic applications.

NOTE

The fiber number concatenated with Fiber Name are interdependent: they 
are incremented or decremented at the same time. 
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Min: -999 / Max: 999 / Auto: 0

No the Fiber number must not automatically modified.

Cable Id
This parameter allows to enter an identification of the cable, using the Edition menu.

Direction
The direction shows if the acquisition has been made from the origin to the extremity (A-
>B) or from the extremity to the origin (B->A). Changing direction makes it possible, 
when different extremities are handled, to see the parameters of the fiber for the other 
extremity.

Location A
The name of the Location A of the link may be entered here.

Location B
The name of the Location B of the link may be entered here.

Project Information

Technician Id
Use the arrow  to enter the name of the operator carrying out the measurement.

Job Id
Use the arrow  to enter a description of the measurement to be performed.

Comment
In contrast to the other data in this menu, the comment is specific to a fiber. This line is 
thus used to enter a new comment and not to display it. The comment appears at the 
top of the screen, with the other parameters of the fiber.
This comment will remain available for the next acquisition, unless it is deleted. It is also 
saved when a trace is saved with a comment.
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Configuring the File parameters
The File storage parameters must be also configured, in order to define how the results 
will be saved on to the SmartOTDR.

In the Setup page, press File soft key (if one parameter is selected in the current screen, 
press Top Menu soft key to display the right menu keys and click on File).

Directory Configuration

Dir. Naming
Click on Current Directory menu key to select the directory currently selected in the 
explorer for files saving

or

Use the arrow  to enter the directory name and path:

In the edition keypad, select the pre-defined parameters available or, press abc 
key to enter a name manually for the directory. Then, press Enter to validate.

Example: disk/Powermeter

NOTE

The softkey Copy File/Link To all is displayed when one parameter is 
selected in the Link or File Setup page and when the Powermeter function is 
active at the same time as another FO application (for example, OTDR 
Expert). 

It allows to apply the Link and File configuration parameters of the current 
applications to all the other active Fiber Optic applications (powermeter and 
source).
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or

Press Auto Naming to apply the name by default to the directory:

disk/[Cable_Id]

Press Clear and validate (Enter key) in order to define the [Current directory] 
selected as directory for saving measurements.

Dir
This parameter cannot be configured, and display the directory selected by default into 
which the file(s) will be saved.

Result Storage

Filenaming
Select Filenaming parameter and press the right arrow key to modify the name of the 
file for the result trace.

In the edition keypad, select the pre-defined parameters available or, press abc 
key to enter a name manually for the file. Then, press Enter to validate.

Fig. 15 Directory - Edition keypad
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or

Press Default Filename to apply the name by default to the file:

Fiber[Cable_Id][Fiber_Num]_[Lambda]_[Direction]

The name of the file is displayed in grey under Filenaming parameter.

Report Configuration

The powermeter results file can be saved with or without a report according to the config-
uration defined.

In the parameter Rapport As, select the format for the report which will be saved with 
the powermeter file:

No only the powermeter results are saved in a filen with the extension.lts

Txt the results are saved, with the extension «.lts» and a txt report file is 
also generated.

If the text report is generated with the results file, the Report Layout parameters turns 
active:

Select the saving mode for the report:

Standard the report is saved in a standard txt file.

Consolidated the report is saved in a text file, into which results are consolidated. 

If the selected parameter is Consolidated, the following parameter, Report Naming, 
turns active and allows to enter a name for the report file. If no name is defined, the file 
will automatically be saved with the name Report_LTS.

Figure 16 Filenaming - Edition keypad (Auto)
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Saving configuration in a file
Once File and Measurement parameters have been configured, those parameters can 
be kept in memory and saved in a configuration file.

This configuration file can then be recalled in order to be applied when powermeter 
measurements are performed.

To save parameters in a configuration file:

1 If necessary, press SETUP to return to Setup page.

2 Select one parameter in one of the setup page (acquisition, link..)

3 Press menu key .

An edition keypad displays

4 Enter a name for the configuration file (max. 20 characters).

5 Press Enter to validate

A sound is emitted to indicate the file is saved.

The configuration file is saved with the extension .fo_cfg (icon ) and can be 
recalled at any time from the Explorer page.

NOTE

Configuration file is saved by default in the directory disk/config/LTS.

Fig. 17 Save Configuration file - Edition keypad

Directory into 
which file will be 
saved
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Loading an existing LTS configuration
To load a configuration file previously created or available in the T-BERD/MTS/ Smar-
tOTDR and apply parameters to new Powermeter tests:

From the File Explorer page

1 Press FILE hard key

2 Select the configuration file desired.

3 Press Load > Load Config.

• Press SETUP hard key to display the configuration parameters saved in the 
selected configuration file.

You can modify some acquisition or file storage parameters, and save them in a new 
configuration file (see “Saving configuration in a file” on page 36).

From the Setup page

1 Select one header in either Setup page (Acquisition, Link, File...)

2 Press Load Config. menu key.

The file Explorer page displays

3 Select the configuration file desired

4 Press Load Config. to load the configuration file for measurements.

A sound is emitted to confirm the loading.

The Setup screen is displayed again.

NOTE

Most of the configuration files are available into the equipment, in disk/
config.
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Display of results and commands
The results page called up by the RESULTS button, gives the information relating to the 
measurement in progress, results previously saved and the commands available for 
measurement and saving.

Result of the measurement in progress
The power measured by the power meter is displayed in large characters, in the units 
selected in the SETUP menu, together with:

• the mode of transmission of the signal measured: continuous (CW) or modulated 
to a frequency of 270Hz, 330Hz, 1KHz, or 2KHz.

• the wavelength of the signal measured. 

• the reference level expressed in dB.

• the level of Attenuation Compensation.

Table of results
For each fiber being tested, the power meter displays a table of 9 results corresponding 
to the different possible wavelengths. The first 4 results are displayed on the screen; to 
scroll through the other results, use the direction key  or touchscreen. The table 
shows the power measured in dBm, the relative power (in dB) and the reference level in 
dBm (if units = dB), together with the mode.

Fig. 18 Loading a configuration file



Chapter 5 Optical options
Using the Power meter via USB port

User Manual 7SMART102 Rev004 39

• A measurement result is displayed in the table when the Keep Result soft key is 
pressed. 

• The Clear Table soft key deletes all the results displayed in the table. 

• If the Alarm function has been activated, any result that exceeds the selected 
thresholds appears in red in the table. Otherwise, results are shown in the table in 
green.

• When the Platform is switched off, results present in table are kept.

Commands of the power meter parameters
When the Powermeter function is selected, the following softkeys are available on the 
results page:

The different configuration buttons are displayed:

Wavelength selection of the wavelength

Unit choice of the unit

Zero Adjustment of the Zero value when the power meter’s optical input is 
closed with a plug or cap (a validation is required).

On the results page, the following actions are available:

Standard Reference
Selects the current result as reference value to measure the insertion 
of a link. This reference is displayed under the measurement result 
until a new reference is performed.

Keep Result Keeps the result on the corresponding line of the table.

Clear Table Deletes all the results displayed in the table.

Figure 19 Results and commands of the power meter

Results of the 
powermeter



Chapter 5 Optical options
Using the Power meter via USB port

40 User Manual 7SMART102 Rev004

If the Source function is selected (either on this Platform / base Unit or on an OTDR 
module), the Power meter results page is different:

• The choice of Wavelength, Unit and Zero menu keys are accessible via the 
menu key Power Config..

Performing a measurement
The power meter is started up as soon as the function  is activated in the HOME 
page.

Power measurement
1 Connect the light source to be tested to the rear connector (see "Connection to 

the power meter and VFL" page 28).

2 In the SETUP menu, choose the units dBm, dB or Watts.

3 Press the START/STOP key to start the measurement. 
The result will appear in the results page and can be memorized in the table (see 
"Table of results" page 38).

4 Press the START/STOP key to stop the measurement.

Optical link loss

Setting the zero value of the power meter

1 Fix the plug or cap over the optical input of the power meter so that no light can 
reach the photodiode of the power meter. If the zero adjustment is made without 
this plug, an error message may be displayed, as the photodiode will detect too 
much light.

Power measurement is automatically updated in consequence. The value 
«<-60 dB» is displayed when the laser is switched off and if the source out-
put is looped on to the power meter input.

It is important to set the zero of the power meter before performing any low 
power level measurement when accuracy is critical, as the noise from the 
photodiode may fluctuate over time and with temperature.
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2 In the Results page, press the Powermeter Config. > Zero soft key and vali-
date.

Carrying out the reference measurement (1-jumper 
reference)

1 Fix the adapter corresponding to the jumper to the optical connector of the power 
meter.

2 Connect the jumper between the input of the power meter and the output of the 
source.

3 Configure the same wavelength on the source and the power meter.

The power measured is displayed in the results page of the power meter.

4 Press the Standard Ref soft key to save the result displayed as reference value.

Measurements on the fiber under test

After defining the reference value, proceed as follows to make the measurement:

1 Fix the jumpers and connectors needed to connect the fiber to be tested between 
the source output and the power meter input.

2 In the set-up menu, select dB units.

3 The power displayed in the Power Meter window corresponds to the optical loss 
of the link tested. It can be displayed in the table (see "Table of results" page 38).

Combo Powermeter/OTDR
If the ExpertOTDR mode is activated at the same time as the Powermeter, a menu key 
Combo PM/OTDR is displayed in the powermeter page.

It allows to launch an OTDR acquisition on the same port as the powermeter, clicking on 
Yes in the dialog box displayed.
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VFL Function

VFL connector
The type of optical connector used for the VFL source is UPP (Universal Push Pull), 
which is compatible with all diameter 2.5 mm connectors (FC, SC, ST, DIN, E2000, etc.)

See Figure 13 on page 28 to visualize the VFL connector.

Visual Fault Locator function (VFL)
This function is used to emit a red light signal of frequency 1 Hz or in continuous mode 
into a fiber to detect any defects in the dead zone of the reflectometer, or to identify it. 

This function is suitable for short fibers (length < 5 km) or the first few metres of a long 
fiber.

Figure 20 Combo Powermeter / OTDR

CAUTION

Only the following SmartOTDR used in combination with the powermeter, 
have the Combo PM/OTDR function; E117FA65PPM-PC, E117FA65PPM-
APC, E136FB-PC and E136FB-APC.
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To emit a light signal into a fiber:

1 Connect the fiber to the VFL port on the connectors panel.

2 Press the HOME key and activate the VFL 

The icons  display on the upper banner of the screen.

The signal mode of the VFL can be modified in the System Settings page, in Utility > 
VFL Mode parameter.

Storing and reloading results

Storing results
In order to save the results of a measurement, click on FILE and select Store trace. Two 
files are being saved:

• The first file is used with the SmartOTDR and allows to retrieve all measurement 
results. It is saved with the extension «.Lts».

• The second file is a ASCII file using tabulations to separate values. It is saved 
with the extension «.txt» and can be opened by the SmartOTDR. It has been 
designed to be used with a spreadsheet program on a PC where it allows to 
retrieve all measurement results and format them in a nice customized table. 

Loading results
In order to load the results of a measurement, select a file  with the extension «.Lts» 
in the file explorer (see the chapter «File management» in the user manual for OTDR 
application), click on Load. 
The LTS tab is displayed with the loaded results in the table.

NOTE

Identification is facilitated by the blinking of light in the fiber.

NOTE

Press CANCEL button on the Platform to deactivate the VFL.
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Chapter 6Scope

The scope function is a hot-plug feature enabled directly when inserting a Viavi scope 
supplied as an accessory (see Chapter 10):

The topics discussed in this chapter are as follows:

• “Scope feature” on page 46

• “Installation of tips” on page 47

• “Configuring the Scope” on page 47

• “Starting up with the scope” on page 56

• “Launching a test of the connector and fiber end-face” on page 58

• “File menu” on page 62
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Scope feature

Overview
This feature enables you to verify that your optical connectors are in perfect shape and 
very clean condition.

The P5000i Digital Probe Microscope and the FiberCheck Probe are a portable hand-
held microscope used to view and inspect both the bulkhead (female) and patch cord 
(male) sides of fiber connectors as well as other optical devices, such as transceivers.

The P5000i and the FiberCheck Probe require an FBPT inspection tip.

The P5000i is connected to the SmartOTDR with a USB 2.0 connector.

The FiberCheck is connected to the SmartOTDR with a mini-USB connector or via WIFI.

Figure 21 P5000i Probe components

QuickcaptureTM button
Instantly captures (and analyzes) fiber image

Focus Control

Latch lock
Squeeze both ends to release

Barrel assembly USB 2.0 
connector

6 FT COIL Cable

Inspection tip

Magnification Control

Before using the P5000i scope, make sure the Bluetooth option has 
not been activated, even once, after the start of the SmartOTDR. If it 
has been activated, stop and restart the equipment before using the 
P5000i Scope.
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Installation of tips
The Pass/Fail analysis function on the SmartOTDR can only be used with certain 
inspection tips mounted on the P5000i.

Seven tips, patchcords and bulkheads types, are delivered with the Videoscope Kit 
(ESDFSCOPE5Ki) but many others can be used.

Configuring the Scope

P5000i Scope connection
1 Plug in your Viavi scope into a USB port from the SmartOTDR.

2 Push the button Home

Fig. 22 FiberCheck Probe components

QuickcaptureTM button:
- Adjust automatically the 
image quality (auto-focus)
- Instantly captures (and 
analyzes) fiber image

Focus Control

Barrel assembly

Inspection tip

Magnification 
Control

QuickcaptureTM button:
- Adjust automatically the 
image quality (auto-focus)
- Instantly captures (and 
analyzes) fiber image

Turn on the Scope

Buttons on FiberCheck probe are also used to navigate onto the 
screen of the product, if it is used alone, without being linked to a Plat-
form (see FiberCheck user manual).
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3 Validate the Scope function .

4 Connect probe with the fiber being inspected.

You may select this option while other options are already selected (e.g. OTDR).

FiberCheck Scope connection

WIFI Connection
1 Turn on the scope.

2 Make sure the WIFI connection is activated onto the Scope (see FiberCheck User 
manual). 

3 On SmartOTDR, press the HOME button.

4 Click on Connectivity > Wireless.

5 Perform a scan to detect the Scope and establish the connection with the Plat-
form (see “Configuring the WIFI access” on page 72).

6 Once connection is established, return to the Home page.

7 Validate the icon Microscope .

You may select this option while other options are already selected (e.g. OTDR).

Fig. 23 Microscope FiberCheck detected via WIFI
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USB Connection
1 Link the scope to the SmartOTDR using a mini-USB cable.

2 Turn on the scope.

3 On the SmartOTDR, press the HOME button.

4 Validate the Fiber Microscope icon .

You may select this option while other options are already selected (e.g. OTDR).

Configuring the Scope
1 Press SETUP key to configure the test.

The following screen displays:

Figure 24 WIFI connection of the FiberCheck Scope to the SmartOTDR
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Analysis

Profile
On the line Profile, select the Profile which will be used for the test of fiber connector:

• SM_UPC Pass/Fail criteria for single-mode UPC connectors from IEC 
61300-3-35 standard.

• SM_APC Pass/Fail criteria for singlemode APC connectors from IEC 
61300-3-35 standard.

• SM_PC Pass/Fail criteria for singlemode PC connectors from IEC 
61300-3-35 standard.

• MM_ Pass/Fail criteria for multimode connectors from IEC 61300-3-
35 standard.

• Ribbon, SM_APC Pass/Fail criteria for ribbon singlemode APC connectors

Profiles contain the analysis parameters by which PASS/FAIL criteria are determined.

Once the line is selected, you can also add a new profile, clicking on the Manage Button 
(see “Managing scope profiles” on page 54).

Tip
On the line Tip, select the tip set onto the scope to connect fiber for inspection.

Figure 25 P5000i Scope Setup
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Capture button
This parameter allows to select the action of the Quick Capture button onto the Scope 
(see Figure 21 on page 46 and Figure 22 on page 47):

• Freeze & Test pressing the button will automatically perform a test of fiber and 
freeze the result

• Freeze image pressing the button onto the Scope will automatically freeze the 
live image.

Auto Center
This parameter allows to select if the scope image must be centered on screen (select 
Yes) or not (select No).

Advanced focus (focus meter)
This parameter allows to define if the advanced focus must be used (Yes) or not (No).

The advanced focus displays a Red / Yellow / Green bar graph to indicate the focus level 
and the image sharpness.

Link
In the Setup page, press Link softkey (if one parameter is selected in the current screen, 
press Top Menu soft key to display the right menu keys and click on Link).

The information entered in the Link window concerns the editing and/or the modifications 
of the cable and fiber parameters.

• Fiber Id Use the edition keypad, which will display by clicking on the 
right arrow key, to enter a specific name for the fiber. 

• Fiber Number Use the numeric keypad, which will display by clicking on the 
right arrow key, to enter the fiber number.

• Change fiber Nbr Select if the fiber number must be modified after each results 
saving:

No: the fiber number is not modified at each saving

CAUTION

This parameter is not available with the FiberCheck scope as the function is 
available by default.

Press the Quick Capture button to apply the auto-focus onto the image (see 
“FiberCheck Probe components” on page 47).
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Increment; the fiber number is automatically incremented at each results saving

Decrement: the fiber number is automatically decremented at each results 
saving.

User Defined: Use the menu key Edit Number to enter the value for incrementa-
tion / decrementation of the fiber number.

Note: to decrement the number, enter the sign «-» before the number. 
Example: -1.

Min: -999 / Max: 999 / Auto: 0

• Cable Id This parameter allows to enter an identification of the cable, 
using the Edition menu.

• Direction The direction shows if the acquisition has been made from the 
origin to the extremity (A->B) or from the extremity to the origin 
(B->A). Changing direction makes it possible, when different 
extremities are handled, to see the parameters of the fiber for 
the other extremity.

• Location A The name of the Location A of the link may be entered.

• Location B The name of the Location B of the link may be entered.

• Company Enter the name of the company carrying out the test.

• Technician Id Enter the name of the operator carrying out the test.

• Job Id  This line is used to enter a description of the job in progress.

File
In the Setup page, press File softkey (if one parameter is selected in the current screen, 
press Top Menu soft key to display the right menu keys and click on File).

The File box allows to configure the saving of scope results.

Dir. Naming

Click on Current Directory menu key to select the directory currently selected in the 
explorer for files saving

or

Use the arrow  to enter the directory name and path:

NOTE

All parameters of the Link Description box will appear in the pdf report gener-
ated from a test results page.
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In the edition keypad, select the pre-defined parameters available or, press abc 
key to enter a name manually for the directory. Then, press Enter to validate.

Example: disk/Scope results

Press Clear and validate (Enter key) in order to define the [Current directory] 
selected as directory for saving measurements.

Dir
The Dir parameter is displayed in grey, and indicates the directory into which the results 
will be saved.

Filenaming
Use the edition keypad, which will display by clicking on the right arrow key, to enter a 
specific name for the file. You can enter manually a name and/or use pre-defined param-
eters (Fiber Id, Cable Id, Locations...).

In the edition keypad, select the pre-defined parameters available or, press abc 
key to enter a name manually for the file. Then, press Enter to validate.

Fig. 26 Directory - Edition keypad
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or

Press Default Filename to apply the automatic name to the file: 
Fiber[Cable_Id][Fiber_Num]_[Direction]

Below Filenaming, the name of the file is displayed.

Logo
Click on right arrow key and select in the Explorer a JPG file which will represent the 
Logo displayed on the upper left part of the report 

Save mode
Select if the test results must be saved only in an Image, only in a pdf Report or in an 
image + a pdf report (Image + Report).

Auto Store
Select Yes if the saving must be done automatically after a test, or No if the saving must 
not be done automatically.

Press Exit to return to the Results screen of the scope.

Managing scope profiles
Once the Setup screen of the scope is displayed, you can :

• Select / unselect a profile from the list, which will be available / unavailable in the 
Setup screen.

• Add a profile to the existing ones.

Figure 27 Filenaming - Edition keypad (auto)
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Defining the profiles available on the Setup screen
Once in the Setup page of the Scope application:

1 Select the Profile parameter to open the sub-menu

2 In the right menu keys, press Manage.

3 From the Profiles list, click on one profile (in video reversed) and press Select / 
Unselect menu keys to add or remove this profile to/from the sub-menu of the 
Setup screen

or

Directly click on the check box of the profile to select/deselect it.

4 Press Top Menu softkey to go back to Setup page.

The changes are applied at selection.

Importing a profile to the Scope application
The profile must be created via FiberChekProTM, and stored on one storage media of the 
SmartOTDR (disk, or USB memory stick).

1 On the Setup screen, select Profile and press Manage.

2 From the Profile list, press Add menu key.

3 On the explorer, select the file which will be used as profile (icon  ; extension: 
.PRO)

4 Press Load.

Once loaded, the display goes back automatically to Manage Profile screen.

Figure 28 List of profiles available
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5 Select the profile just loaded.

6 Press Top Menu to return to Setup screen and select the profile just added.

About page
On the Setup screen, the softkey About, on the right of the screen, allows to display 
information on scope and current test result displayed (in Full Screen mode or mosaic 
mode - see “Mosaic Mode” on page 60).

1 Press About softkey to display a page as the following one:

Starting up with the scope
Once the FiberScope icon is validated:

1 Press RESULTS hard key

Figure 29 P5000i Scope: About page

Information on 
scope used

Information on 
active snapshot
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Use the Focus Control button onto the scope (see Figure 21 on page 46 or Figure 22 
on page 47) to adjust the image quality and sharpness.

Freeze mode
Once the image is acceptable, you may freeze the picture. This feature allows to store 
in memory the resulting picture.

Figure 30 Example of the result using the P5000i scope

Sharpness 
level

NOTE

To switch from Scope page to FO results page and vice-versa, press the 
RESULTS hard key for about 2 seconds (a beep is emitted).

Freezing a scope result does not store the picture in a file (see “File 
menu” on page 62). The result will be lost if the instrument is shut off, 
or if more than 3 pictures are frozen (see “Mosaic Mode” on page 60)

NOTE

The button set on the lead, or the QuickCapture™ on the scope allows to 
freeze the picture and/or to perform a test (according to the configuration in 
Setup page - see “Configuring the Scope” on page 47).
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High Mag. / Low Mag.
The High Mag./Low Mag. menu key allows to switch the display from High to Low 
magnification and vice-versa.

This function is also available pressing the button directly on the scope (see Figure 21 
on page 46 and Figure 22 on page 47). 

Live mode
If you are in Freeze mode, or in Mosaic mode, with a picture selected (see “Mosaic 
Mode” on page 59), press Live menu key to return to live camera picture.

Launching a test of the connector and fiber end-
face

Launching a test of the connector and fiber end-face
Once the display is correctly adjusted (magnification, sharpness...), a test of fiber 
connector can be launched.
To launch the test:

1 Press Test key or QuickcaptureTM button to launch the test of plugged fiber 
connector.

The test is completed:

– once the Led Testing is no more lit in red

– once the icon  is no more displayed on the upper banner

– once a screen as the following one displays:

Use the focus control to adjust the focus of the image

NOTE

To configure Pass/Fail criteria, see "Configuring the Scope" page 49.
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A summary of test results is displayed on the right, upper part of the screen.

• Zone A: Core zone: it is the area surrounding the core

• Zone B: Cladding zone. It surrounds the majority of the 
fiber cladding.

• Zone C: Epoxy ring.

• Zone D: Ferrule/Contact zone: it identifies a portion of 
the ferrule near and around the fiber

Overlay
The Overlay key allows, when selected, to display the limits of each zone and to display 
with colors the defaults on the image.

Figure 31 Test results

Test result in 
High mag.

Profile selected in 
the Setup page

Summary of 
Test results

NOTE

To return to a Live Camera image, press the Camera key; or press the Full 
Screen/Mosaic key view both the live image and a test result simultane-
ously.

In Mosaic mode (see "Mosaic Mode" page 60), the result of the test only dis-
plays Pass or Fail information; the status of each zone is displayed only in 
full screen mode.

Zone C
Zone B

Zone A

Zone D
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When the key is deselected, the zones and defaults are not graphically identified.

This function is also available in Mosaic Mode (see “Mosaic Mode” on page 60).

Mosaic Mode
It is possible to display only one picture in full screen (640 * 390 pixels) or up to four 
pictures (320*180 pixels each, including the live camera picture) in mosaic mode. Use 
the key Full scr./Mosaic to switch from one mode to another.

• You may select one of the pictures by clicking on it.

The selected picture is framed in green.

The tool bar on the right varies according to which picture is selected (camera, or static 
picture):

Picture selected: Live

Test Allows to launch a (new) test of the connector (see “Launching a test 
of the connector and fiber end-face” on page 58) 

Figure 32 Mosaic mode

Position 1 :
LIVE CAMERA

Position 2:
File saved on disk

Selected picture
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Freeze The live picture from the camera is frozen but does not replace the 
live picture at position 1. The new snapshot is placed at the second 
position, and all existing pictures are pushed to the next position.

High mag./Low mag.
Allows to modify the live display from high to low magnification and 
vice-versa

Picture selected: Image

Save Image allows to save the selected picture in the directory Scope, in the disk 
of the Platfom. Press Save key, enter a name for the jpg file and vali-
date. This key is not available with jpg files other than those resulting 
from scope application.

Comment allows to add a comment to the selected picture (see “Adding a 
comment” on page 61)

Overlay The Overlay key allows, when selected to display with colors the 
defaults on the image.

When the key is deselected, the zones and defaults are not graphi-
cally identified.

High mag./Low mag.
Allows to switch all the images from scope test results from high to 
low magnification and vice-versa.

Adding a comment

The key Comment allows you to enter/modify a comment to your picture if necessary. 
This comment appears at the bottom left of the picture. 

The right bottom of the frozen picture also contains the date of the acquisition (where the 
picture was frozen).

If all positions were taken, the picture that was once at the fourth position is 
unloaded from memory. Frozen pictures and snapshots are lost, unless they 
were saved on the internal memory.

NOTE

Both the comment and the date will be saved with the picture.
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Loading a picture
It is possible to retrieve and load a picture stored in the Scope directory and display it in 
the Scope page.

1 Press the FILE button.

2 Select the JPEG file to be loaded via the Explorer

3 Click on Load

Recognized pictures are images resulting from the Scope option and saved on disk via 
the SmartOTDR.

Even though the JPG editor of the Scope function has been designed to display Scope 
pictures in black & white, it is also possible to open any JPG valid file and display in color 
the corresponding picture. That picture is enlarged or shrunk to the size of the display 
(full screen or mosaic, see."Mosaic Mode" page 60).

File menu

Saving the test result in a jpg file and / or in a report
Once the test has been performed, and the result is displayed on the SmartOTDR 
screen:

1 Click on Save Image soft key to save a jpg file and / or a pdf report of the test 
result on the disk of the SmartOTDR.

2 On the edition keypad, enter the name of the file(s)

3 Press Enter to validate.

The file is automatically saved on the disk, in the directory Scope (icon  for 
jpg file, icon  for report).

The jpg file includes pass/fail and setup information which is used for combo 
report with OTDR (see OTDR User Manual).

Some pictures resulting from the Scope option may appear neverthe-
less unrecognized, if they have been stored with a different Scope 
application, or if the JPG file has been opened and modified under 
another JPG editor.
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Display of the report
Once the report has been generated:

1 Press FILE hard key.

2 In the File Explorer, select the pdf report just created.

3 Press Load.

Figure 33 PDF report of Scope test result

Parameters selected in 
the Setup page (see 
“Configuring the 
Scope” on page 49)
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Chapter 7Connectivity

This chapter describes the different ways to access to the SmartOTDR interface or 
content using different connection modes.

Topics described in this chapter are as follows:

• “Establishing connection” on page 66

• “Remote Control” on page 81

• “Stratasync” on page 101
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Establishing connection

Via Bluetooth
The Bluetooth interface allows interface and file transfers. 

It is an option that must be installed at the factory.

Installing the Bluetooth option onto the SmartOTDR
The Bluetooth option is delivered on a USB dongle to be connected to the board which 
will be inserted into the SmartOTDR.

To install the Bluetooth option onto the equipment:

1 Switch off the SmartOTDR and, if necessary, unplug it from mains.

2 Remove the cover on the underside of the Platform, unscrewing the two screws.

If the board is already set into the Platform, follow instructions on step 4.

3 Insert the board, pressing it gently but firmly, taking care to the connectors.

The product is approved in accordance to R&TTE directive 
concerning transmitter module marked by CE0678. It is 
manufactured by MITSUMI and it is an OEM product.
This device complies with Part 15 of the FCC Rules. Operation is 
subject to the following two conditions: (1) this device may not 
cause harmful interference, and (2) this device must accept any 
interference received, including interference that may cause 
undesired operation. This device contains FCC-ID: POOWML-C40.
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4 Insert the Bluetooth into the connector of the board.

5 Screw back the cover onto the Platform

6 Restart the SmartOTDR, pressing ON button.

The Bluetooth option can be launched.

Pairing the Platform with a device
1 On the Home page, press Connectivity key

2 Under Connectivity page, select Bluetooth

Figure 34 View board and connectors

Figure 35 Bluetooth set into the Platform

An external USB dongle is also available (reference E60EBLUE).
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The following screen displays

3 Press the menu key Bluetooth  to enable the Bluetooth interface.

The icon  is displayed on the upper banner of the screen

The Paired Bluetooth Devices screen appears

4 Press the Become Pairable soft key to wait for another device to initiate the 
connection to the SmartOTDR.

A screen as the following one displays:

5 Activate Bluetooth on the equipment which need to be paired with the Platform

Figure 36 Bluetooth disabled

Figure 37 Waiting for pairing
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6 If you are asked to, validate a pairing code on the equipment.

7 In this case, validate the pairing code on both equipments.

Both equipment are now paired:

The icon has a blue background when paired with a device , versus no back-
ground when not paired .

Searching new devices to be paired with the 
Platform
1 If the desired device is not displayed on the screen, or if no devices are detected, 

press the Search Devices soft key.

The SmartOTDR is searching for the devices which could be used via Bluetooth 
with the equipment.

A baragraph is displayed during research  

Once the research is completed, a list of the available devices is displayed, with 
the level of detection of the SmartOTDR 

Figure 38 Platform paired with one equipment

REMINDER

You may need to activate bluetooth on the other device to allow pairing.



Chapter 7 Connectivity
Establishing connection

70 User Manual 7SMART102 Rev004

a Select the device to be paired with the Platform

It will be underlined in blue.

b Push the Pair key to connect the device to the Platform

2 If prompted, enter a pairing code. The code must be identical on the SmartOTDR 
and the device.

3 Once the bluetooth device and the Platform are paired, a screen is displayed with 
the description of the device (see Figure 38 on page 69).

The icon has a blue background when paired with a device , versus no back-
ground when not paired .

You can now go to the file explorer and transfer files from the SmartOTDR toward the 
bluetooth device and vice versa (see “Transferring files via Bluetooth” on page 95).

Removing the Pairing
To remove the pairing between the two equipments

1 From the Home page, press Connectivity > Bluetooth.

2 Push the Remove pairing key

The icon on the upper banner of the screen becomes  showing the Platform is 
no more connected to a bluetooth device, but the Bluetooth option is still active.

To deactivate the bluetooth onto the Platform, press Bluetooth menu key to disable the 
interface.

Figure 39 List of devices found
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Via Wifi
The WIFI application is available on option with the SmartOTDR, ref E10WIFI.

Installation of the WIFI option in the Platform
The WIFI option is delivered on a USB key to be connected to the WIFI board which will 
be inserted into the SmartOTDR.

To install the WIFI option onto the Platform:

1 Switch off the SmartOTDR and, if necessary, unplug it from mains.

2 Remove the cover on the underside of the Platform, unscrewing the two screws.

If the board is already set into the Platform, follow instructions on step 4.

3 Insert the board, pressing it gently but firmly, taking care to the connectors.

4 Insert the WIFI USB key into the connector of the board.

Figure 40 View board and connectors

Figure 41 WIFI USB set into the Platform
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5 Screw back the cover onto the Platform.

Configuring the WIFI access
1 Restart the SmartOTDR, pressing ON button.

2 On the Home page, press Connectivity .

The Connectivity page opens.

3 In the new page, select the WIFI icon .

The WIFI Setup screen displays.

4 Press Wireless menu key to enable the Wifi interface.

The icon  is displayed on the upper banner.

Once the Setup screen is displayed, configure the WIFI connection:

5 Press Scan SSID menu key to scan for Service Set Identifiers (SSIDs) in the 
area.

6 Wait for the list of SSIDs to be displayed.

An external USB dongle is also available (reference E60EWIFI).

Figure 42 WIFI Setup screen
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7 Select the desired network to connect to.

8 Press Select menu key to validated the connection.

The display goes back to Setup screen.

The SSID parameter is automatically configured with the one selected.

9 In Encryption parameter, select the type of encryption wished: None, WEP 
Static, WPA Personal, WPA Enterprise.

10 According to encryption type selected, enter Login (if any needed) and Key/
Password.

11 In the AutoConnect parameter, select if the connection to SSID selected must be 
done automatically (On) or not (Off).

Connection to SSID
Once configuration is valid, connect the SmartOTDR to the Wireless network:

1 In the Setup screen, press Connect SSID menu key.

or

If AutoConnect is defined to On, the connection is launched automatically.

Figure 43 List of SSIDs found

NOTE

Login and Password are kept in memory, even if the WIFI is deactivated or 
the SmartOTDR switch off and restarted.
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Once association of Platform with SSID is established, the icon    becomes 
 to indicate the connection is active.

Configuring the WIFI mode to which the Platform is 
connected
To work on WIFI with the Platform, configure the 802.11 parameter on the WIFI Setup 
screen.

1 Select the mode of connection: 

• Config 1 to 4 static mode enabling input of the configuration of 4 sites. If this 
parameter is selected, the following parameters must be 
entered:

– Site Name the user can enter the name of the site in the Edit menu.
– IP Address IP address of the SmartOTDR
– IP Mask address of the mask of the sub-network
– IP Gateway IP address of the machine enabling access outside the sub-

network.
– DNS (Domain Name Server) IP address of the machine providing the 

IP address on the basis of the name

• Dynamic in this mode, which requires a DHCP server, the SmartOTDR 
requests an IP address from this server which will be allocated 
dynamically if dynamic host configuration is activated on the 
local network.
After selecting this mode or after power-on, the SmartOTDR 
tries to establish a connection to obtain an address from a 
DHCP server. If for any reason, this process fails, the 
SmartOTDR reverses to static IP address mode with User1 IP 
address.

Note the IP address of the Platform, to be able to remote screen on PC or to transfer 
files.

Figure 44 WIFI connection in Dynamic mode

Note IP 
Address
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2 Configure the Proxy dialog box:

In the Use proxy parameter

– Select No if no proxy is used.

– Select Manual to enter manually the Proxy address

– Select Auto and enter the Pac address.

Creating a network from the SmartOTDR
A WIFI network can be created from the SmartOTDR, in order to associate it to a  Smart-
phone or Tablet.

1 From the Home page, press Connectivity > Wireless 802.11.

2 On the Setup screen, select the Wlan Mode for WIFI connection: Ad-hoc (IBSS) 
or AP Master.

3 Press Create Network menu key and wait for the network creation.

The network creation on platform is completed once the dialog box is no more 
displayed.

4 On the Smart device, open the Wifi setup age.

5 Check the Platform has been detected (SSID identifier displayed in the list of 
WIFI networks found)

6 Click on this SSID and follow the instruction on your Smart Device to link it to the 
Platform.

Via Ethernet
The connection between SmartOTDR and the PC can be done directly, or via a local 
network.

Connecting the SmartOTDR and the PC
1 Connect the SmartOTDR to the PC via an Ethernet cable, using the USB 

Ethernet - adapter and an ethernet cable.
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2 Make sure the network configuration onto the PC is set to the Dynamic mode:

a Click on Start > Control Panel.

b Double click on Network Connection.

c Double click on Local Area Connection.

d In the dialog box, click on Properties.

e Check the parameter Internet Protocol (TCP/IP) is selected ( ) and click 
once on it (underlined in blue)

f Click on Properties button.

g On the tab General, check the parameter Obtain an IP address automati-
cally is selected ( ); if not, click to select it.

h Click on Ok and close all the dialog boxes opened onto the PC.

Figure 45 Connection SmartOTDR and PC

Figure 46 Internet Protocol
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Configuring the SmartOTDR via Ethernet
1 In the Home page, validate the Connectivity icon.

2 In the connectivity page, validate the Ethernet icon 

3 In the I/O Interfaces box, configure the following parameters:

Remote Screen

Remote screen = Session or Permanent must be confirmed in both cases, in the Inter-
face E/S window.

• No the screen cannot be remote on to a PC or on to another 
SmartOTDR.

• Session Mode the Remote screen function is inactive once the 
SmartOTDR is switched off.

• Permanent Mode the Remote screen function is still active when the 
SmartOTDR is switched off and restarted.

• Permanent with password
Same function as the Permanent mode, with an access 
to the equipment via VNC protected by a password: 
42000

The password to access VNC can be modified:

1 Click on the menu key Change password.

2 Enter the current password in the Edition keypad and press Enter to validate.

3 Enter the new password and press Enter to validate.

Ethernet > Mode

Parameters of the local Ethernet network to which the SmartOTDR is connected:

• Config 1 to 4 static mode enabling input of the configuration of 4 sites. If this 
parameter is selected, the following parameters must be 
entered:

– Site Name the user can enter the name of the site in the Edit menu.
– IP Address IP address of the SmartOTDR
– IP Mask address of the mask of the sub-network
– IP Gateway IP address of the machine enabling access outside the sub-

network.
– DNS1 IP address of the machine providing the IP address on the basis 

of the name
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– Domain name name of the local network to which the SmartOTDR is 
connected.

• Dynamic in this mode, which requires a DHCP server, the SmartOTDR 
requests an IP address from this server which will be allocated 
dynamically if dynamic host configuration is activated on the 
local network.
After selecting this mode or after power-on, the SmartOTDR 
tries to establish a connection to obtain an address from a 
DHCP server. If for any reason, this process fails, the 
SmartOTDR reverses to static IP address mode with User1 IP 
address.

Proxy > Use proxy

1 Select No if no proxy is used.

2 If Manual has been selected, enter the Proxy Address.

3 If Auto has been selected, enter the Pac Address.

4 Note the IP Address.

5 Wait about 10 seconds the connection is established.

The SmartOTDR Interface can now be transferred onto the PC, or the internal memory 
or USB key contents can be transferred on PC.

1.Domain Name Server

NOTE

Once the SmartOTDR is connected to the network, the icon  indicates 
the connection is working.

Figure 47 Example of configuration for I/O Interfaces box

Note the SmartOTDR IP 
Address
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Via Cloud Storage

Principle and prerequisites of the Cloud Storage
The Cloud storage defined the outsourcing of data on distant servers, which avoid the 
data storage on a local workstation.

The cloud storage onto a SmartOTDR allows to transfer the files from the Platform 
toward a distant server and vice-versa.

Before configuring the Cloud Storage on Platform, you must first create an account on a 
Cloud Platform on internet. 

The Cloud storage function onto the SmartOTDR works exclusively with sites 
using the WebDav technology such as CloudSafe (https://secure.cloudsafe.com/
pages/index.html) or Box (https://www.box.com/pricing/).

Once account is created, with WevDav configuration, you get the following information 
for connection:

– URL 

– Login Name

– Login Password

Configuring and connecting to Cloud Storage on the 
SmartOTDR

Configuring the SmartOTDR

Once an account has been created on the Cloud site, configure the SmartOTDR before 
establishing the connection:

1 On the Home page, press Connectivity.

2 In the Connectivity windows, press Cloud/File Storage .

A new page opens

Before configuring the Cloud Storage, make sure the configuration 
for Ethernet parameters and Proxy parameters are correctly 
configured. 

See “Ethernet > Mode” on page 77 and “Proxy > Use proxy” on page 78.

https://www.box.com/pricing/
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3 In the Url parameter, enter the URL define for the Cloud server created on 
internet

4 In the User parameter, enter your Login created on your account

5 In the Key / Password, enter the password attributed by the Cloud server.

Connecting Cloud Storage

Once configuration has been established on the SmartOTDR, it is ready to be connected 
with Cloud server:

1 Select one parameter of the Cloud Storage window on SmartOTDR

2 Press Connect Cloud Storage menu key .

The connection launches

3 Once connection is established, a message displays in the window

4 Press any key to continue, and start files transfer.

The icon  is displayed on the upper banner as long as the connection is active.

Figure 48 Example of configuration

Configuration on Cloud server 
(example with CloudSafe)

Configuration on SmartOTDR
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Disconnecting from Cloud storage

To disconnect the SmartOTDR from Cloud storage:

1 Press HOME hard key.

2 Select a parameter of the Cloud Storage window.

3 Press Disconnect Cloud Storage menu key.

Remote Control

Smart Access Anywhere
The SmartOTDR can be accessible to any network test locations, using a specific func-
tion: Smart Access Anywhere. 

This function allows one distant user, on a PC, to transfer the Platform Interface and 
work on SmartOTDR or to access the internal memory / USB memory stick contents on 
the PC and perform files transfer from SmartOTDR to PC and vice-versa.

This feature does not need any license code if the user wants assistance from a Viavi 
person located within the Viavi network.

This feature requires a license code into the unit if the user wants any other assistance/
support (“company A” willing to be remotely controlled by “company A or B”).

The license E10SAA-L2 is used for SmartAccessAnywhere using Ethernet, wifi hostpot 
connection, or USB / Wifi connection through smartphone

The SmartOTDR can be used in combination with a PC in order to transfer the Platform 
Interface onto a PC, or to access the internal memory or USB memory stick contents on 
the PC. 

Connection modes
Different kinds of connection are available to access to a distant SmartOTDR.

According to the connection type used, specific requirements are mandatory.

WIFI connection

1 The WIFI connection can be used to access to SmartOTDR from any location.
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This connection is available exclusively if the WIFI option is installed onto the 
SmartOTDR which will be seen remotely.

USB/WIFI connection via Smartphone (Tethering)

To access to a SmartOTDR remotely, the connection between the unit and the Viavi 
application can be established via a USB cable or WIFI, and through a Smartphone, 
having Internet Sharing capability via USB or WIFI.

1 To establish connection between SmartOTDR and Smartphone using USB, 
connect the USB cable on SmartOTDR and on Smartphone connector.

Figure 49 WIFI connection

Figure 50 USB connection through Smartphone
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2 To establish connection between the SmartOTDR and Smartphone using WIFI, 
the WIFI option must be installed onto the SmartOTDR.

Pre-requisite for using the Smart Access Anywhere 
Application
To access to a SmartOTDR from any locations, specific requirements are mandatory:

• a licence installed on SmartOTDR which will be accessible from any locations.

• an Ethernet connection (the Platform must have an IP address - see “Ethernet > 
Mode” on page 53) and, if the network uses a proxy, this proxy must be config-
ured (see “Proxy > Use proxy” on page 54).

• the Viavi application, downloaded for free at the address «http://smartac-
cess.updatemyunit.net».

• port 22 (SSH) or 443 (HTTS) output opened

• according to connection mode selected:

– the WIFI option installed on SmartOTDR

– a USB cable to connect SmartOTDR with Smartphone

– a Smartphone from given list and having appropriate basic subscription for 
internet connection sharing

Downloading the Viavi application on PC
The Viavi application Smart Access Anywhere must be downloaded on the PC which 
will be connected to the SmartOTDR remotely.

Figure 51 WIFI connection through Smartphone
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1 On PC, open an internet explorer and type the following address: http://
smartaccess.updatemyunit.net

2 Click on the link SmartAccessAnywhere_Vxx.xx.xx.zip 

3 Select Save in the dialog box.

4 Open the directory into which has been save the zip file and unzip files into a 
directory

5 Open the directory and double click on SmartAccessAnywhere.exe 

The Smart Access Anywhere application opens:

If the software version is not the last one available, a message displays, on the upper 
part of the screen to indicate the latest version available can be downloaded at the 
address: http://smartaccess.updatemyunit.net.

NOTE

It is not necessary to have administrator privileges to install the Viavi applica-
tion on PC. This application is just saved on PC.

Figure 52 Smart Access Anywhere: Connection page

Enter Access Code
(see step 3 on page 86)
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Downloading the Viavi application on Tablet/
Smartphone
The Viavi application Smart Access Anywhere can be downloaded on a Smartphone 
or tablet which will be connected to the SmartOTDR remotely.

1 On Smart device, open an internet explorer page and type the following address: 
http://smartaccess.updatemyunit.net

2 Click on the link SmartAccessAnywhere_Vxx.xx.xx.apk 

The downloading starts.

Some security messages can be displayed.

3 Follow the process on the Smart device to confirm the installation of the applica-
tion on the instrument.

4 Once the installation is completed, the icon appears on Tablet/Smartphone.

5 Click on the icon to launch the SmartAccess Anywhere application.

Launching the SmartAccess Anywhere application
Once connection is configured, the SmartAccess Anywhere application can be launched

On SmartOTDR

1 On the Home page, select the SmartAccess icon 

Figure 53 Warning message of a new version available

NOTE

It is not necessary to have administrator privileges to install the Viavi applica-
tion. This application is just saved on the smartphone or tablet.
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As soon as the icon is selected, the SmartOTDR begin to connect to SmartAcc-
essAnywhere Server.

2 Once connection is established with the server, the SmartOTDR displays a 
message with the code to be used to access to the equipment remotely.

3 Note this access code and transfer it to the distant user, who will access the unit 
remotely.

4 Press OK to hide the message.

On the distant PC

1 On the PC of the distant user, once the application is launched, enter the Access 
Number on the upper part of the screen.

2 Click on Connect to validate 

The following screen displays:

Figure 54 Access code displayed
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Using Remote screen and File Transfer applications
Once the Introduction page is displayed, the user can work on distant SmartOTDR:

• transfer the interface to work on the unit (perform acquisition, configure the equip-
ment...)

• transfer files from the equipment toward the PC, and vice-versa.

Transferring the interface onto the PC/Smartphone/Tablet

To display the remote SmartOTDR onto the PC:

1 On the Introduction page, click on  

or

On the left menu, click on 

The current screen of the SmartOTDR displays:

Figure 55 Smart Access Anywhere: Home page

Information on 
connection

After remote upgrade or reboot, please wait for more than 2 minutes 
before re-starting the link between the PC and the unit with SmartAcc-
essAnywhere.
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The VNC icon  on the upper banner of the unit indicates the remote screen 
is active.

2 On the upper part of the screen, the virtual control buttons bar is permanently 
dipslayed and allows to emulate hard keys.

You may click on any of these buttons to obtain exactly the same results than 
using the hard keys on the front panel of the SmartOTDR.

3 You can use keyboard mouse of the PC to control the SmartOTDR (see “Equiva-
lence between the keyboard and SmartOTDR” on page 100).

Transferring files

To work on files (onto PC and onto unit):

1 On the Introduction page, click on .

or

On the left menu, click on .

The file Explorer on PC and the one of the SmartOTDR displays:

Figure 56 Smart Access Anywhere: Remote screen

Virtual control buttons bar
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2 Double-click on one directory/storage media to display the contents (directories / 
sub-directories / files)

Navigation buttons

 

Transferring files from PC to SmartOTDR

1 On the SmartOTDR explorer, select the storage media, and if wished the (sub-
)directory into which file will be transferred.

2 On the PC file explorer, select the file to be transferred

3 Click on the button Upload .

Figure 57 File Transfer page

PC
Directories and files

SmartOTDR
Storage media available

Return to the Home directory

Select the PC drive in the list

Access to parent directory

click
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At the bottom of the screen, a new banner displays with information on file 
transfer:

Once transfer is completed, the banner disappears and the transferred file is underlined 
in blue on SmartOTDR explorer.

Transferring files from SmartOTDR to PC

1 On the PC explorer, select the storage media, and if wished the (sub-)directory 
into which file will be transferred.

2 On the file explorer of the SmartOTDR, select the file to be transferred.

3 Click on the button Download .

A dialog box open, allowing to modify the location on PC of the file.

4 Select the directory into which file will be saved.

5 Press Save to start the transfer

Under both file explorers, a new banner displays with information on file transfer 
(see Figure 57 on page 89).

Once transfer is completed, the banner disappears and the transferred file is underlined 
in blue on PC explorer.

Figure 58 Information on file transfer

1
2
3
4

1: location of the uploaded file on PC 3: level of transferred data

2: location of the file on SmartOTDR 
once transfer is completed

4: bar graph of the transfer 
in progress

Only one file can be uploaded from PC to SmartOTDR at the same 
time.
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Working with files and directories on SmartOTDR

Renaming file or directory

1 Select a file/directory stored on the SmartOTDR hard disk or USB key.

2 Click on .

3 In the new dialog box opened, enter a new name for the file/
directory, keeping the file extension.

4 Press OK to validate.

Deleting file

1 Select a file stored on the SmartOTDR hard disk or USB key.

2 Click on .

3 In the new dialog box opened, press Yes to confirm 
the deletion (or No to keep the file).

Creating a new directory

1 Select the storage and, if wished, the directory into which the new directory will be 
stored.

2 Click on .

3 In the new dialog box opened, enter a name for the new direc-
tory (newdir is given by default).

4 Press OK to validate.

The new directory is automatically created at the location selected.

Connection information and settings

Displaying session information

At any time during application use, the information about the session in progress can be 
displayed.

1 Press Session menu key on left of the screen .

A screen as the following one displays:
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This page gives information on connection «in real time».

Modifying connection settings 

To modify the settings for connection to internet:

1 Press Session menu key on left of the screen  .

2 Disconnect from application pressing  

3 On the session screen (see Figure 59 on page 92), press button .

The following screen displays:

Figure 59 Session page
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By default, the connection is defined to Smart-guess (default).

4 To modify the current parameters, select Forced settings.

The parameters for Port configurations turn automatically active.

5 Modify, if necessary, the port used: Default port (22) is selected by default

6 Select Alternative port (443) if necessary

7 If the parameter Alternative port (443) is selected, you can defined if the proxy is 
used or not in the following parameter.

The Internet proxy configuration is available exclusively if the port selected is 
Alternative port (443) and if the Proxy is selected..

8 Once configuration is completed, press .

The Home page displays (see Figure 55 on page 87).

Figure 60 Connection settings

It is recommended to configure parameters of connection with your 
local network administrator, if the default parameters need to be modi-
fied.
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Testing connection

Before entering the Access code to activate the application, the connection to internet 
can be tested from displayed screen.

1 Open the Smart Access Anywhere application on PC

2 Press  button

The test is automatically launched

3 Press  to display logs in real time

Once completed, the results for connection display:

The screen displays, in two different tables:

• the Upload and Download speed (in Kbyte/s) from Device to server.

• the Latency between Device and server (in ms).

4 Press  to delete the current table, and retest connection if wished.

5 If connection is valid, enter the access code and establish connection (see 
“Launching the SmartAccess Anywhere application” on page 85 - “On the distant 
PC” on page 86).

Figure 61 Test results
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Data Transfer
The SmartOTDR enables to transfer files, from or toward the product using Wifi, Blue-
tooth or Ethernet connection.

Transferring files via Bluetooth
Once the connection has been established with a bluetooth device:

1 On the Home page, press File Explorer key to go in the File Explorer.

2 Select the file(s) to be transferred from the Platform toward the PC.

3 Push Export > Send by Bluetooth menu keys .

A confirmation message displays once the transfer is completed.

You can also transfer file(s) from the bluetooth device toward the Platform.

In this case, the files received will be stored in a storage media created automatically on 
the Platform: bluetooth-inbox.

Figure 62 Confirmation of files sending
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Transferring files to/from a PC via WIFI or Ethernet
Once connection is established between the Platform and the PC:

1 On the PC, use an FTP client, and access to internal memory via an internet 
explorer (I.E, Mozilla Firefox...) or Windows Explorer.

2 In the address bar, type the following address (10.33.16.229 being the IP 
address of the SmartOTDR defined when the connection was configured):

ftp://mts1000:JDSU@10.33.16.229/disk/
This allows to access to internal memory.

ftp://mts1000:JDSU@10.33.16.229/usbflash/
This allows to access to the contents of the USB memory stick connected to the 
SmartOTDR.

Figure 63 Confirmation of file receiving

WARNING

The files stored in bluetooth-inbox will be lost once the SmartOTDR is 
switched off. Copy/Paste the files to keep toward another storage 
media (disk, usb key...).

If you use Internet Explorer 7, the following address must be entered:

ftp://mts1000:JDSU@10.33.16.229/acterna/user/disk or ftp://
mts1000:JDSU@10.33.16.229/acterna/user/usbflash
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3 If an identification is required, enter:

– User name: mts1000

– Password: JDSU

The PC then displays the contents of the internal memory or of the USB memory 
stick from the SmartOTDR.

4 If internal memory of the Platform is accessible via Internet Explorer (or any other 
explorer), right click on one file and click on Save target as... to transfer file onto 
the PC.

If internal memory of the Platform is accessible via Windows Explorer, select one 
/ several files and click on Copy, then click on Paste on PC to transfer file(s).

Transferring files using Cloud Storage
Once connection between SmartOTDR and cloud storage server is successfully estab-
lished (see “Configuring and connecting to Cloud Storage on the SmartOTDR” on 
page 79), the files can be transferred from one Platform to the other.

1 Press HOME hard key.

2 Press Explorer on the Home page

In the Explorer page, a new storage media is available: cloud-storage.

Figure 64 Internal memory of the SmartOTDR

Internal memory open via Internet Explorer Internal memory open via Windows Explorer

The cloud-storage media is not available when File Explorer is opened 
from a FO application.
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3 Transfer the files from the disk or USB memory stick of the SmartOTDR toward 
the cloud storage or vice-versa:

a Select the file(s) to be transferred

b Press the Edit > Copy or Cut menu keys

c Select the storage media (and the directory) into which files must be copied.

d Press Paste menu key

VNC
The SmartOTDR can be used in combination with a PC in order to transfer the  Interface 
onto a PC, or to access the internal memory or USB memory stick contents on the PC.

The transfer of the interface can be done using a VNC window on PC.

Figure 65 File Explorer with cloud storage

Edition 
menu

The cloud storage is automatically disconnected once the SmartOTDR 
is switched off. Reconnect from the System Settings page of the Smar-
tOTDR after the Platform restart.

For an intensive use of the deport screen or when it is used via a WAN 
network, it is strongly recommended to use a dedicated VNC client. 
The VNC clients recommended are Tight VNC (V 1.2.9 or later) and Real 
VNC (V 4.1.1 or later).
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Transferring the interface on a PC via WIFI or 
Ethernet
Once the connection is established between the SmartOTDR and the PC, proceed as 
follow:

1 Open Internet Explorer on the PC.

2 Considering 10.33.16.229 is the IP Address of the SmartOTDR (as shown 
Figure 44 on page 74), enter the following address in the Internet Explorer 
window:

http://10.33.16.229:5800

3 Press Enter to validate.

The screen of the SmartOTDR appears offset on your PC.

See “Virtual control buttons bar” on page 100 and “Equivalence between the keyboard 
and SmartOTDR” on page 100 to get information on the deported screen use.

Figure 66 VNC window

Click to install TightVNC 
software on your PC (not 
mandatory) 

NOTE

Once Remote screen is accessible via VNC, the icon  displays on the 
upper banner of the screen until the connection is cut or the SmartOTDR is 
switched off.
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Virtual control buttons bar
It is possible to emulate hard keys with Virtual Control buttons. This virtual control bar is 
especially useful when the SmartOTDR screen is exported on a remote PC.
To display those buttons, click once on the top of the screen in the status bar, at the same 
height than the date and time.

The virtual control buttons bar is displayed during a few seconds. You may click on any 
of these buttons to obtain exactly the same results than using the hard keys on the front 
panel of the SmartOTDR.

Equivalence between the keyboard and SmartOTDR
The PC keyboard can replaced all the buttons and keys of the SmartOTDR except the 
ON/OFF button: 

• The menu keys to the right are replaced by the function keys F1 to F6.

• The buttons below the screen are equivalent to Ctrl + a letter (see table below).

• The direction keys have the same function on the external keyboard and on the 
SmartOTDR.

Figure 67 Virtual control buttons bar

Function on the SmartOTDR External keyboard 

HOME Ctrl + H

SET-UP Ctrl + U

FILE Ctrl + F

RESULTS Ctrl + R

START/STOP Ctrl + S

EXPORT Ctrl + Pa

a. The Export function is available directly on the SmartOTDR pushing simultaneously 
the left and right arrow keys.

←  ↑  →  ↓
Menu keys 1 to 6 (from top to bottom) F1 → F6

Validate a selection Entrée/Enter

Deselect a function on the Home page Escape/Echap.
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Stratasync

Principle and prerequisites of the Stratasync
Stratasync is a new solution that provides network operators with an agile and central-
ized way to manage and analyze data from thousands of deployed Viavi test instruments 
directly from the cloud.

StrataSync is a hosted, cloud-based software application that provides Viavi instrument 
asset, configuration, and test-date management.

StrataSync improves technician and instrument efficiency. 

StrataSync allows to: 

• Manages and tracks test instruments

• Collects and analyzes results from the entire network

• Informs and trains the workforce

NOTE

Those equivalences are also valid with a keyboard directly connected to the 
SmartOTDR via one USB port.
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Pre-requisites for using the Stratasync with the SmartOTDR

The user must have subscribed to Stratasync, and by consequence, he must have 
acquired an account Identifier and a password.

The Ethernet and Proxy parameters must have been correctly configured in the System 
Settings page of the SmartOTDR (see “Ethernet > Mode” on page 77 and “Proxy > Use 
proxy” on page 78).

Configuring and synchronizing the SmartOTDR
The SmartOTDR can be configured to be synchronized with the Stratasync.

1 On the Home page, press Connectivity.

2 Check the configuration of the Ethernet and Proxy parameters (see “Configuring 
the SmartOTDR via Ethernet” on page 77

3 In the Connectivity windows, press Stratasync .

4 Configure the Stratasync parameters:

a In the Server Type parameter, the Viavi Server is selected by default and it 

Figure 68 Principle of the Stratasync application

Instruments are 
dialed in: the latest 
configurations and 

software

Techs are empowered: 
“right the first time” 
with the latest test 

instruction

Visibility throughout 
the entire network:  all 
results are immediately 

useful

Lots of data in

Simple 
data out
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is recommended to keep this parameter.
However, the user can select if necessary the Server Name parameter and 
enter the name in the following parameter.

b In the Account ID parameter, enter the same identifier as the one used to 
access to Stratasync.

c The Technician ID parameter is automatically fulfilled after synchronization 
(if it has been defined by the administrator of the Stratasync)

d To upload the files from a directory onto the SmartOTDR toward Stratasync, 
select the parameter Upload from and press right arrow key to enter the 
directory path (example: disk/Stratasync). The directory Stratasync is 
defined by default.

Connecting the SmartOTDR to Stratasync
Once SmartOTDR is configured in the System Settings page:

1 In Home page, press Stratasync icon .

The synchronization with Stratasync starts

The icon  displays on the upper banner of the SmartOTDR during synchroni-
zation.

Once the icon is no more displayed, this mean that the synchronization is 
completed.

2 For the first synchronization only, a message displays on the SmartOTDR to indi-
cate the addition of the equipment in Stratasync.

Figure 69 Stratasync configuration
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The SmartOTDR is now available in Stratasync.

Figure 70 First synchronization - Message on SmartOTDR
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Chapter 8File management

This chapter describes the files management using a SmartOTDR.

The topics discussed in this chapter are as follows:

• “File Explorer Overview” on page 106

• “Directories and Files selections” on page 106

• “Directories & Files editing functions” on page 108

• “Working with directories and files from the explorer” on page 109

• “Creating a screenshot” on page 111

• “Merging pdf or txt files” on page 112

• “Storage media” on page 113
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File Explorer Overview
To reach the File Explorer page

• On the Home page, select the File Explorer icon.

The File Explorer page displays.

Directories and Files selections

Directory selection
To select a directory from the explorer page:

1 Press on the directory that must be selected on the left of the screen.

The list of files the directory contains displays on the right side of the screen

The selected directory is underlined in blue

2 Click on the arrow at the left of the directory name, or press validation hard key 
, to display the sub-directories if any.

Figure 71 File Explorer page

Figure 72 Directory selection

Selected directory

Sub-directory

Access to sub-
directory
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Files selection
To select one or several files from the explorer page:

1 Press on files that must be selected.

or

To select a list of files using the keys of the Platform:

a Select and validate the first file of the list (underlined in red)

b Set the cursor on the last file of the list (underlined in blue)

c Maintain the right direction key  pushed until all the files are selected.

or

Click on Select all menu key to select all files into the directory.

NOTE

The last selected file is underlined in red and the previous one(s) selected is/
are underlined in blue. 

Figure 73 Example of files selection

Selected files

Selected 
directory



Chapter 8 File management
Directories & Files editing functions

108 User Manual 7SMART102 Rev004

Directories & Files editing functions

Copy/Cut & Paste files/directories
To copy (cut) one or several files, or one directory, and paste them in another place:

1 Select the directory / the file(s) (see “Directories and Files selections” on 
page 106).

2 Press Edit menu key

3 Press Copy to keep the directory / file(s) to their initial location.

or

Press Cut to delete the directory / file(s) from their initial location

4 On the left of the screen, select the directory; or select the new storage media.

5 Click on Paste menu key.

Renaming a directory / file
1 Select the directory / file to be renamed (see “Directories and Files selections” on 

page 106).

2 Press Edit > Rename Directory or Rename File.

The Edition keypad displays.

3 Press Clear if you wish to delete the entire name

4 Enter a new name for the directory / file.

5 Click on Enter to validate the new name.

Figure 74 Edition keypad for renaming file
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Deleting a directory / file
1 Select the directory or file(s) to be deleted (see “Directories and Files selections” 

on page 106).

2 Press Edit > Delete.

A confirmation dialog box displays.

3 Press Yes to delete the selected directory or file(s).

Press No to cancel the deletion.

Working with directories and files from the 
explorer

Creating a directory
To create a new directory from the explorer page:

1 Check the cursor is set on the left of the screen

2 Select the storage media into which the directory must be created

3 If you want to create a sub-directory, select the directory into which it must be 
created.

4 Press the right menu key Create Directory.

The edition keypad displays

5 Enter a name for this directory

6 Press Enter key to validate the new directory

Opening files
Once a file is selected, press Load menu key.

Opening several files at the same time can be done exclusively with 
trace files (example: all OTDR trace files if a reference trace has been 
defined). Other type of files (PDF, TXT...) must be open one by one.

If different types of files have been selected in the Explorer, only the 
last one selected will open.
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File Types
For files recognized by the SmartOTDR, the types are symbolized by icons. E.g.

Sorting files
Wether files are selected or not, the key Sort allows to access to a sub-menu allowing 
to sort the file according to pre-defined parameters:

• Sort by name: the files display in an ascending order (from A to Z). If you click 
once again on the key, the files display in a descending order (from Z to A).

• Sort by size: by clicking once on this key, the files display from the smallest to 
the heaviest one. Clicking a second time allows to sort the files in opposite order.

• Sort by type: clicking once on this key; the SmartOTDR displays files in an 
ascending order (the file type A to file type W). By clicking again, the SmartOTDR 
displays the files in opposite order.

• Sort by date: clicking once on this key; the SmartOTDR displays files from the 
more recent to the less one. By clicking again on key, the Platform displays files 
from the older to the more recent one.

Icon Type of FO file

OTDR file (.SOR extension)

Multi OTDR file (.MSOR extension)

Power Meter file (.LTS extension)

Icon Type of file

PDF File (.PDF extension)

Text file (.TXT extension)

License file (.LIC extension)

CSV file (.CSV extension)
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Creating a screenshot
You can create captures of what is displayed on the screen, directly from the Smar-
tOTDR and save it into a pdf file.

Taking a screenshot
Once the screenshot parameters are configured:

1 Reach the display which will be saved as a screenshot in a file.

2 If necessary, make modifications on this display (example: zoom on trace...)

3 Press simultaneously the left and right arrow keys  for about 5 seconds

or

Click on the upper banner of the screen and, in the virtual control buttons bar, 
press Export key 

The icon  displays until the end of process.

4 Press the FILE key to find the PDF file in the Explorer.

For trace results, the file is saved in the same directory than the file used for 
screenshot., or in the last directory selected.

For other page open and used for a screenshot, the file is saved in the directory 
Print into the disk.

Name of the screenshots files
The screenshot is saved in a file, which is automatically named as follow: 

• Print_date (year/month/day)_time (hour/minute/second).pdf

NOTE

You can also sort files clicking on the column titles in the files list
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Merging pdf or txt files
In the Explorer page, two pdf/txt files or more, generated via the results traces can be 
merged in one pdf file.

• The pdf files that can be merged are those generated via the Fast Report key on 
trace results page or via the Export key on the upper banner (or left and right 
arrow keys).

• The txt files that can be merged are those saved with the results trace (see OTDR 
Application User Manual).

1 In the Explorer, select the two or more pdf/txt files generated

2 Press Export menu key

3 Press Merge key

Figure 75 Example of screenshot, open on the SmartOTDR
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The icon  is displayed during merging process.

After a few seconds, the files are merged in one pdf/txt file, which name by default is: 
merged_year_month_date__hour_min_sec.pdf/txt. 

The file is automatically saved in the same directory as the one where files have been 
selected.

It gathers all results from pdf/txt files selected (and traces for pdf file), in one single pdf 
file of several pages (1 results screen per page, if the results table does not exceed one 
page).

Storage media
For saving or recalling data, the SmartOTDR offers a wide choice of media, both built-in 
and external.
Free space on selected media is clearly displayed at the bottom of the left panel.

Figure 76 Files selection and Merge key

NOTE

Once merged file is saved, it can be renamed in the Explorer (see “Renam-
ing a directory / file” on page 108).
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Storage media built into the SmartOTDR
The SmartOTDR is delivered with an internal memory, which maximum capacity is of 
2GB (with a minimum of about 128 Mb are available for data storage).

External USB storage media
The SmartOTDR is equipped with 2 USB ports as standard. One of these can be used 
to connect an external storage medium, in particular a USB memory stick.

USB memory stick connection
1 Insert the USB memory stick in one of the SmartOTDR's USB port. 

A sound is emitted to confirm the successful insertion and recognition of a USB 
memory stick.

Then, the icon  is displayed in the upper banner to inform the user the USB 
stick is ready to be used.

USB memory stick disconnection
1 Before disconnecting the USB memory stick, always select a storage device 

different from usbflash (select disk for example) in the explorer. 

2 Make sure you no longer have any running applications using the usbflash 
storage media.

3 The user must push the EJECT USB key, available in File Explorer.

The icon becomes  to indicate it can be removed safely. In this state, the 
USB stick cannot be used anymore

NOTE

Although two USB ports are present, it is not possible to use simultaneously 
more than one external USB storage medium. 

When a file is moved in the explorer of the Platform, the end of the 
move on the screen does not mean that writing of data into the mem-
ory is complete. Some data may still be in a writing process if the stor-
age unit is removed prematurely. 
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The USB memory stick can then be disconnected from the Platform USB port.

See Chapter 11 “Maintenance and Troubleshooting” if any problem occurs with the USB 
memory stick

Abbreviations for storage media
The abbreviations used in the explorer for the different storage media are:

NOTE

The USB memory stick can also be removed using the Expert Tools > 
Media Utilities menu, accessible via the System Settings page.

Abbreviation Storage medium

disk Internal flash memory

usbflash USB memory stick

bluetooth-inbox Bluetooth storage media (option)a

a. The files stored in bluetooth-inbox are lost when the SmartOTDR is switched off.

cloud-storage Cloud storage media available on PC
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Chapter 9Technical specifications

This chapter contains the technical specifications of the SmartOTDR mainframe.

The topics discussed in this chapter are as follows:

• “General specifications” on page 118

• “Characteristics of the Source (standard) and Power Meter (optional)” on 
page 121

• “Characteristics of the options” on page 122

• “Characteristics of the OTDR” on page 123
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General specifications

Display specifications

Screen

• Backlight high visibility color capacitive touchscreen

• Size: 5 inches 

Resolution

• 800 x 480 pixels

Memory
Standard memory: internal memory, with a capacity of 2GB (with a minimum of about 
125 Mb are available for data storage).

Input/Output
• Two USB 2.0 host ports.

• One Mini USB 2.0 device

• Built-in buzzer

• Built-in WIFI (optional)

• Built-in Bluetooth (optional)

Battery
The instrument can be supplied with one Li-Polymer battery or AA dry pack battery.

Li-Polymer Battery charging time

If the battery is completely discharged, the time taken to recharge is:

• approximately 5 hours, if the apparatus is not in use (Charge indicator solid red)

• about 10.5 hours if the instrument is used during charging (On indicator lit in fix 
green, Charge indicator lit in solid red).



Chapter 9 Technical specifications
General specifications

User Manual 7SMART102 Rev004 119

Endurance of the SmartOTDR with battery

Measurement conditions:

– at +25 °C, 

– at full battery capacity (4.8 Ah),

Mains adapters

Supply or Power assigned in AC and in DC: 25 W

Li-Polymer Battery

Conditions of use Endurance

According to Telcordia GR-196-CORE recommendation:
Normal conditions, with normal backlight, 3 acquisition of 30 seconds 
per quarter of hour, auto off

up to 20 hours

Under continuous acquisition, with high screen backlight:
with a E136FB SmartOTDR

Up to 5h45

AA Dry Battery Pack

Conditions of use Endurance

NiMH Alkaline

According to Telcordia GR-196-CORE recommendation:
Normal conditions, with normal backlight, 3 acquisition of 
30 seconds per quarter of hour, auto off

up to 7h15 Up to 6h15

Under continuous acquisition, with high screen backlight:
with a E136FB SmartOTDR

Up to 2h45 Up to 2h30

Standard Mains Adapter

Input 100-250 V, 50-60 Hz

Output 12V DC 2.5 A max

Compliance EN 60950
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Dimensions - Weight

Dimensions

175 x 138 x 57 mm (6.9 x 5.4 x 2.4 in)

Weight

About 900 gr (1.98 Ib) 

Environment

Temperature
• Operating temperature range: -20°C to +50°C (-4°F to +122°F)

• Operating temperature range with guaranteed specifications: 0°C to +40°C 
(+32°F to +104°F)

• Storage: -20°C to +60°C (-4°F to +140°F)

Humidity
• 5 to 95% without condensation

EMI/ESD
• CE Compliant (EN61326-1)

• FCC 47-1 Part 15 Compliant

Drop test
In accordance with the Telcordia GR-196-CORE recommendations, the SmartOTDR 
resists the following test: 

• 6 impacts dropped from a height of 76 cm on a pinwood floor of 5 cm thickness (1 
impact on each of its 6 sides, with power off).

Shocks
The SmartOTDR resists the following test:
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• 3 shocks per axis along each of the 3 axes, with power off.

• Impacts of 15g, 1/2 sine, duration 11 ms, at 10 second intervals.

Bumps
The SmartOTDR resists the following test: 

• 1,000 bumps per axis along each of the 3 axes, with power off.

• Jolts of 15g, 1/2 sine, duration 6 ms, at 1 second intervals.

Vibration
The SmartOTDR resists the following vibration tests:

• Complete test comprising 6 cycles along each of the x, y and z axes.

• One cycle of 5 to 200 Hz and back to 5 Hz with a sweep duration of one minute/
octave.

• 3 mm amplitude displacement test, for the range 5 Hz to 15 Hz.

• 3g acceleration test for the range 16 Hz to 200 Hz.

Flammability
The SmartOTDR housing (in ABS, type V0) does not propagate fire.

Characteristics of the Source (standard) and Power 
Meter (optional)

Source
• Output Power Level1: -3.5 dBm

• Stability long term (8h): ± 0.05 dB2

Power meter (through OTDR port)
Specifications given for 25°C, after 20 minutes stabilization time and after zero setting.

1.+/- 1 dB
2.After 30min light source stabilization time
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• Calibrated wavelengths: 1310 / 1490 / 1550 / 1625 / 1650 nm

• Accuracy at calibrated wavelengths: ± 0.5 dB (at -30 dBm)3

• Input power range: -60 dBm to +10 dBm

• Maximum resolution: 0.01 dB / 0.01nW

• Measurement range:0 to -55 dBm

• Linearity: ± 0.5 dB4

PON/XG-PON Power Meter (E118FA65PPM version)
• Wavelengths: 1490/1550 nm; 1490/1578 nm

• Measurement ranges

– 1490 nm: -35 to +5 dBm

– 1550/1578 nm: -35 to +23 dBm

• Measurement accuracy: ± 0.5 dB

• Channels isolation from external source: 

– 1310/1490: > 40dB

– 1550 to 1650: > 20dB

Characteristics of the options

VFL
• Wavelength: 650 nm

• Length of fiber: up to 5 km

• Class 2 laser (standards EN60825-1 and FDA21 CFR Part 1040.10).

Bluetooth and WIFI
• WIFI: standard IEEE802.11n

• Bluetooth Option

– Class 2

– Range: up to 20 meters

– Bluetooth V2.1 + EDR

3.Except 1650 nm
4.from -5 dBm to -50 dBm
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Characteristics of the OTDR

OTDR Optical Interfaces
Interchangeable optical connectors: FC, SC5

OTDR Optical characteristics

Characteristics of reflectometry measurements 

Distance measurement 

• Automatic or Dual cursor 

• Distance displayed takes into account the calibration of the refractive index of the 
fiber.

• Index adjustable from 1,30000 to 1,70000 in steps of 0,00001

• Resolution of display: 1 cm max.

• Resolution of cursor: 1 cm max.

• Spacing of measurement points: from 4 cm, with up to 256 000 acquisition points.

5.SC mandatory for E136FB configuration

Laser safety class (21 CFR) Class 1

Distance units Kilometer, meter, feet, and miles

Group index range 1.300000 to 1.700000 in 0.00001 steps

Number of data points Up to 256,000 data points

Distance measurement Automatic or dual cursor

Display range 0.1 km to 260 km for single-mode

Cursor resolution 1 cm

Sampling resolution 4 cm for single-mode

Accuracy
±1 m ±sampling resolution ±1.10–5 * x distance 
(Excluding group index uncertainties)
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• Accuracy: ± 1m± sampling resolution ±1.10-5 x distance
(excluding errors of calibration of refractive index of the fiber).

• Display span: 0.1 km m to 260 km for single mode

Attenuation measurement 

• Automatic, manual, 2-point, 5-point, and LSA

• Resolution of display: 0,001 dB

• Resolution of cursor: 0,001 dB

• Linearity: ± 0.04 dB/dB for single mode

• Display span: 1.25 dB to 55 dB

Reflectance / ORL Measurement

• Resolution of display: 0,01 dB

• Accuracy: ± 2 dB

Automatic measurement

• Automatic measurement of all the elements of the signal. Slope measurement by 
least squares or 2 points of measurement.

• Display threshold of faults:
- 0 to 5.99 dB in steps of 0.01 dB for event thresholds 
- -11 to -99 dB in steps of 1 dB for the reflectance
- 0.01 to 5.99 dB in steps of 0.01 dB for attenuation

• Display of slope and attenuation for a segment of fiber.

• Display of the position of a fault and of attenuation.

• Display of the reflectance of the fault.

• Display of ORL

Manual Measurement
• Measurement of slope between the cursors.

• Measurement of attenuation between two segments of fiber.

• Measurement of reflectance of a reflecting element.

• Measurement of ORL between the two cursors.

• Measurement of splice by 2 or 5 points method 
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Typical specifications
Typical values, measured at 25°C unless specified.

100B Series 100A Series

Central Wavelengtha
1310 ± 20nm
1550 ± 20nm

filtered 1625 nm ± 20nm 

1310 nm ± 20nm
1550 nm ± 20nm

filtered 1650 nm ± 20 nm

Cut Wavelength range on live 
port (filtered)

1290 - 1580 nm
Isolation > 45 dB

Typical RMS Dynamic Rangeb 40 / 40 / 41 dB 37 / 35 / 32 dB

Distance Rangec Up to 150 km Up to 100 km

Pulse width 3 ns to 20µs 5 ns to 20µs

Event Dead Zoned 0.90 m 1.35 m

Attenuation Dead Zonee 2.5 m 4 m

Splitter Attenuation Dead Zone 45 m after 15dB splitter loss N/A

a. Laser, at 25° C and measured at 10 µs
b. Typical value corresponding to the one-way difference (in dB) between the extrapolated backscattering level at the beginning of 

the fiber and the RMS (SNR = 1) noise level, after 3 minutes averaging and high dynamic resolution, using the largest pulse 
width.

c. At 1550 nm
d. EDZ measured at ± 1.5 dB below the peak of a unsaturated reflective event using the shortest pulse width.
e. ADZ measured at ± 0.5 dB from the linear regression, using a FC/UPC- type reflectance, at shortest pulse width.
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Chapter 10Options and accessories

This chapter shows the references of the options and accessories of the SmartOTDR.

The topics discussed in this chapter are as follows:

• “References of the SmartOTDR” on page 128

• “References of accessories” on page 130

• “References of firmware applications” on page 130
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References of the SmartOTDR

OTDR Configurationsa Reference

SmartOTDR 1550nm A Range Handheld Tester With Continuous 
Light Source & PC Connector

E100A-PC

Activation Key to add 1310 nm Wavelength to a SmartOTDR E113-UPG

SmartOTDR 1550nm A Range Handheld Tester With Continuous 
Light Source & APC Connector

E100A-APC

SmartOTDR 1310/1550nm A Range Handheld Tester With Contin-
uous Light Source & PC Connector

E126A-PC

SmartOTDR 1310/1550nm A Range Handheld Tester With Contin-
uous Light Source & APC Connector

E126A-APC

SmartOTDR 100B 1310/1550 nm Handheld Tester With Continu-
ous Light Source and PC connector

E126B-PC

SmartOTDR 100B 1310/1550 nm Handheld Tester With Continu-
ous Light Source and APC connector

E126B-APC

SmartOTDR 100A Handheld Tester With Two Ports (PC) and Con-
tinuous Light Source: - Standard 1310/1550 nm Port - Filtered 
1650nm Port for In-Service Measurement

E138FA65-PC

SmartOTDR 100A Handheld Tester With Two Ports (APC) and 
Continuous Light Source: - Standard 1310/1550 nm Port - Filtered 
1650nm Port for In-Service Measurement

E138FA65-APC

SmartOTDR 1310/1550nm & Filtered 1625nm B Range Handheld 
Tester With Continuous Light Source & PC Connector

E136FB-PC

SmartOTDR 1310/1550nm & Filtered 1625nm B Range Handheld 
Tester With Continuous Light Source & APC Connector

E136FB-APC

SmartOTDR 100A Filtered 1650nm Handheld Tester With PON 
Power Meter (1490nm + 1550nm Or 1490nm + 1577nm) & APC 
Connector

E118FA65PPM-APC

SmartOTDR 100A Filtered 1650nm Handheld Tester With APC 
Connector

E118FA65-APC

a. Comes with AC/DC converter/adapter, hands-free carrying case, stylus and getting started manual. 
OTDR connector adapter and battery type (LiPo mandatory for E126A and E136FB) are not included.
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OTDR Connector Adapters Reference

SC Universal Adapter (standard) EUSCADS

FC Universal Adapter (accessory) EUFCADS

LC Universal Adapter (accessory) EULCADS

SmartOTDR Mainframe option Reference

Calibration Report E10OTDRCR

Battery Reference

Lithium Polymer battery for SmartOTDR (tray + batteries) (see 
“Changing the battery” on page 151)

E10LIPO

AA dry battery pack for SmartOTDR (tray + batteries) E10DRYBAT

Power Meter / VFL options Reference

Built-in VFL option with UPP 2,5 & 1,25 mm connectors for SmartOTDR E10VFL

Optical power meter option for SmartOTDR (same port as OTDR) E10PM

MP-60A;USB Optical power meter with accessories MP-60A

MP-80A;USB Optical power meter high power with accessories MP-80A

WIFI / Bluetooth options Reference

Built-in WiFi Option for SmartOTDR E10WIFI

Built-in Bluetooth Option for SmartOTDR E10BLUE

External WiFi USB Dongle E60EWIFI

External Bluetooth USB Dongle E60EBLUE
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References of accessories

References of firmware applications

Scope Reference

Digital Videoscope kit including FBP-P5000i probe (USB2.0) in a 
small soft case, and 7 tips in a box (FC, SC, SC-APC, LC, U25M, 
U25MA & U12M)

EDFSCOPE5Ki

Carrying Cases Reference

Hands-free soft case with neckstrap for SmartOTDR (Standard with 
all configurations)

E10GLOVE

Large carrying soft case for SmartOTDR E40SCASE1

Mains options Reference

12V Car lighter adapter for SmartOTDR E40LIGHTER

EU/US to India type D power adapter EINDIADPLUG

Applications for SmartOTDR Reference

Smart Test only option for SmartOTDR. License key enabling only 
the Smart Test mode, the Expert OTDR is removed

ESMARTTEST-100

FTTA-SLM OTDR Application for SmartOTDR ESMARTFTTA-100

FTTH-SLM OTDR Application for SmartOTDR ESMARTFTTH-100

SLM OTDR Software Option for SmartOTDR ESMARTLINK-100

CABLE-SLM OTDR Software Option for SmartOTDR ESMARTCABL-100

Smart Access Anywhere for SmartOTDR -L2: Remote coaching 
and file transfer for SmartOTDR using Ethernet, WIFI and selected 
3G Smartphone (via USB or WIFI)

SAA-100-L2
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Chapter 11Maintenance and Troubleshooting

This chapter describes how to maintain your unit and identify and correct problems 
related to the SmartOTDR.

The topics discussed in this chapter are as follows:

• “Maintenance procedure” on page 132

• “Recycling Information” on page 147

• “Troubleshooting” on page 148

• “General information on warranty” on page 153
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Maintenance procedure
Maintenance work on this instrument must only be undertaken by qualified personnel 

using suitable equipment.

In most cases, it is advisable to contact the nearest Viavi Service Centre, which will 
undertake the appropriate troubleshooting and repair work.
The performance and technical complexity of the SmartOTDR class this instrument in a 
new generation of equipment, for which Viavi has laid down a maintenance policy based 
on the principle of standard module replacement.
In implementation of this policy, we have set up powerful card troubleshooting test 
resources in our factories and a rapid dispatch system operating between our factories 
and branches.
Only by this procedure can the high quality of the instrument continue to be ensured after 
repair work. This procedure also has the advantage of reducing repair costs and time.

In the interests of quality and efficiency, we strongly recommend adoption of the 
following procedure in the event of a fault, before any other steps are taken:

• Verify that the instrument is plugged in.

• Check the connections of any peripheral equipment to the Platform.

• If a fault is detected, or in case of doubt, it is advisable to contact the nearest 
Viavi Service Centre, which will undertake the appropriate repair work. 

Cleaning

Cleaning plates and housings
The front and rear plates and the housings may become tarnished with handling. To 
clean them, use only a rag moistened with soapy water.
Never use any product containing acetone, trichlorethylene, benzine or alcohol, as these 
will attack the printed markings.

Cleaning the screen
To clean the screen, use an antistatic product.
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Cleaning the optical cable connector
• Use a non-fluffy type of paper, such as Joseph paper, soaked in isopropylic 

alcohol.

• Pay particular attention to the polished face of the fiber, rubbing it in a direction 
perpendicular to the axis of the fiber.

Cleaning the optical connections of the SmartOTDR
• Squirt a highly volatile solvent (such as isopropylic alcohol) into the connector.

• Blow out the connector using a clean dry air supply from an aerosol can fitted with 
an extension.

Accessing to the SmartOTDR information 
On the SmartOTDR, some screens allows to display information on different elements 
of the equipment.

To display the information on the SmartOTDR

1 On the Home page, validate Settings icon to reach the System Settings page.

2 On the right menu keys, press About to display the presentation screen of the 
SmartOTDR.

General page
The General page is displayed by default, and allows to display the presentation screen, 
with all the information concerning the software versions, the hardware options and the 
OTDR module.

NOTE

If your equipment has a universal connector, unscrew its adaptor to access 
the ferule.
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This page shows:

• The software version information

• The product contents: base, optical options, battery type, touchscreen used, 
module type and date of calibration for options.

The options set into the SmartOTDR are marked with a green tick.

Software options page
This page allows to visualize the software options available on the SmartOTDR.

1 Once on the About screen, press Software Options menu key to display the list 
of software options available on your SmartOTDR.

Figure 77 General page
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Services Data page
This page allows to display information about the elements inside the SmartOTDR 
(CPU, Memory, hardware revision, screen reference...).

1 Once on the About screen, press Services Data menu key to display the list of 
elements contained on your SmartOTDR.

Accessing to the Platform documentation
The Getting started document for the SmartOTDR use is directly available onto the 
equipment:

Figure 78 Software Options page

Figure 79 Services Data page
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1 Validate the Help icon  on the Home page

The Getting Started Manual displays, in the pdf reader.

Installing a new version of the software

Downloading from Internet
When the software is obtained from the Internet, it must be saved on a storage medium 
before the software upgrade of the product can be carried out. To do this:

1 Open Internet Explorer

Figure 80 Getting Started manual

When a new software version is loaded, there is a risk of re-initialization of 
the internal memory. Before installing the new software, it is therefore advis-
able to save the results in the memory.

Do not interrupt the installation process, as this could damage the instru-
ment.

To avoid any interruption of the installation procedure, the SmartOTDR must 
be operating on the mains: if the procedure is started while operating on bat-
tery, a message indicates that the instrument must be connected to the 
mains.
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2 Enter the internet address  http://www.updatemyunit.net, which will give access to 
the installation/update portals for all Viavi products.

3 Click on the link SmartOTDR® Platform.

A new page opens, displaying the current version available

4 According to your region, click on the one of the following icon to download the 
archive.

Download from European server

Download from North American server

Download from Singapore server

5 In the new dialog box displayed, click on Save to save the exe file on the PC.

6 Once completed, connect the USB memory stick to the PC and follow the instruc-
tions chapter “Installation from a USB memory stick” on page 139, from step 2.

Installation from Viavi Server
The update can be performed directly onto the equipment, using the Viavi server.

1 Connect the SmartOTDR to a PC via an Ethernet cable or via WIFI.

2 Check on the WIFI setup page that the connection mode is defined to Automatic 
(Home > Connectivity > /WIFI> Mode: Dynamic).

3 On the Home page, press Connectivity icon .

4 Press Upgrade icon .

5 In the Upgrade Server box:

– On the line Address Type, select Viavi Server

The address smartotdr.updatemyunit.net is automatically displayed.

6 Select if the new release for SmartOTDR must be automatically detected 
(Enable) or not (Disable). See “Checking new upgrade on Viavi Server” on 
page 141.

7 Press Software Upgrade > Upgrade via Ethernet.
The message Verify IP address of PC server appears. 

Figure 81 Configuration of the Viavi Server
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8 Click on Continue.
The list of the software versions available on the PC is displayed next to the 
versions installed on the SmartOTDR.

Installation from another server
Before starting the software upgrade via Ethernet, make sure the IP address of the PC 
server.

The update can be performed directly onto the equipment, using an http address.

1 Connect the SmartOTDR to a PC via an Ethernet link or via WIFI.

2 Check on the Ethernet or WIFI setup page that the connection mode is defined to 
Automatic (Home > Connectivity > Ethernet / WIFI> Mode: Dynamic).

3 On the Home page, press Connectivity icon .

4 Press Upgrade icon .

5 In the Upgrade Server box:

– On the line Address Type, select Server Name or IP Address.

– Enter the Server Name (if Server Name has been previously selected) or the 
Server Address (if IP Address has been previously selected)

6 Select if the new release for SmartOTDR must be automatically detected 
(Enable) or not (Disable). See “Checking new upgrade on Viavi Server” on 
page 141.

Figure 82 List of software versions (current and new)

Software versions 
installed on Platform

Software versions avail-
able on selected media 
for update
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7 Press Software Upgrade > Upgrade via Ethernet.
The message Verify IP address of PC server appears. 

8 Click on Continue. 
The list of the software versions available on the PC is displayed next to the 
versions installed on the SmartOTDR (see Figure 82 on page 138).

Installation from a USB memory stick
You must be equipped with a USB memory stick with a minimum capacity of 128 Mo.

Before installing the upgrade, you must format the USB memory stick (see “Formatting 
the USB memory stick onto the SmartOTDR” on page 149).

1 Once formatted, disconnect the USB memory stick from the SmartOTDR using 
the key Eject USB available pressing Settings > Expert Tools > Media Utilities.

2 Connect the USB memory stick to the PC

3 Unzip the upgrade files on the PC and transfer it to the USB memory stick:

a Download and save on your PC the.exe upgrade file that you can get from 
the web ( http://updatemyunit.net see “Downloading from Internet” on 
page 136). 

b Once the transfer is completed, double click on the.exe file: A window will 
appear. Check that the folder is correct i.e. the USB memory stick driver is 
appearing in the line at the bottom of the dialog box then press OK. If not, 
click on the icon  in order to select the right USB drive.

As for any media formatting, please note that all data present on the USB 
memory stick will be irremediably lost.

Figure 83 List of software update

http://www.jdsu.com
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c Press OK and wait for the end of loading.

4 Then remove the USB memory stick, using the appropriate procedure, from your 
PC

5 Insert the memory stick into one of the USB ports on the product.

6 On the Home page, press Connectivity icon .

7 Press Upgrade icon .

8 Press Software Upgrade > Upgrade from USB.
The message Are you sure? is displayed

9 Click on Confirm. 

The list of the software versions available on the USB stick is displayed next to 
the versions installed on the SmartOTDR (see Figure 82 on page 138).

Launching the upgrade
Whatever is the method selected for upgrade (Server, USB key...) and once the list of 
the software versions available is displayed next to the versions installed on the Smar-
tOTDR (see Figure 82 on page 138), follow these instructions to launch the upgrade:

1 Click on Show Prev choice or Show Next Choice to display the previous and 
next versions available.

2 Click on Confirm this Choice to start the upgrade of the selected software(s). 

or
Click on Confirm All Choices to upgrade all versions.

Upgrading begins. The SmartOTDR is automatically rebooted. Upgrading takes 
several minutes. Finally, the SmartOTDR is automatically restarted.

NOTE

A bip is emitted each time the USB memory stick is inserted or removed from 
the USB port.

NOTE

The software versions list does not always appear (cf previous versions) as 
well as the Previous / Next Choice buttons and the Confirm/Continue key. 
In this case, the upgrading starts automatically.
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Checking new upgrade on Viavi Server
If the Viavi Server is selected for upgrade (see Figure 81 on page 137), the parameter 
Check new release can be defined to automatically inform user of a new upgrade avail-
able for Platform.

1 In the Connectivity screen, press Upgrade icon.

2 Check the Address Type is set to Viavi Server.

3 Define the parameter Check new release to Enable.

If the parameter is set to Enable, a message displays, at any time, when one 
update is available on server.

4 Press Ok to display the list of software versions available (see Figure 82 on 
page 138) and follow instructions “Launching the upgrade” on page 140.

Upgrading from the boot
This method is used to make a complete reinstallation of the software versions.

1 Turn off the SmartOTDR using the ON/OFF button, keeping the equipment 
connected to the mains.

During the upgrade, the Testing indicator is lit in red. Do not push any 
button or remove the USB memory stick while the indicator is lit. The 
USB stick can be removed if necessary once the Testing indicator is 
off.

Figure 84 Checking new release
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2 Insert the USB stick onto which the software versions are stored into one of the 
USB port of the Platform

3 Press simultaneously SETUP + START/STOP buttons

4 Maintaining the two buttons pressed, press ON button to start the SmartOTDR.

5 A menu displays, then the screen allows to select Upgrade from USB

After a few seconds, a new page displays indicating that to continue the reboot, 
the validation key must be pressed.

Press the hard key  .

The reboot starts automatically.

Once the upgrade is completed, the SmartOTDR will automatically turns on and 
display the Home page.

Install Software License
This page allows to import the license to get a software option.

The Testing indicator will be lit in red during upgrade. Do not 
push any key or remove the USB memory stick until the lit turns 
off.



Chapter 11 Maintenance and Troubleshooting
Maintenance procedure

User Manual 7SMART102 Rev004 143

To import the license, you can either enter manually the licence code, given in the 
license file, (.lic file) or import this file with a USB memory stick connected to the Smar-
tOTDR.

Enter Manually the License
1 In the Home page, click on Settings icon .

2 Press successively the menu keys Expert Tools > Install Option > Enter Chal-
lenge.

The edition keypad is displayed

Figure 85 Example of a License file (.lic)

Licence Code

It is strongly recommended to perform the installation using the 
importation of License via a USB memory stick.
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3 Enter the challenge code of the option, set at the bottom of the file (see Figure 85 
on page 143),

4 Press the Enter key to validate the code.

Your software options will be installed.

At the end of this sequence you will be asked to reboot the unit to apply the modi-
fications, pushing the key . Confirm the reboot to restart the Platform.

Import the license from the USB memory stick

1 In the Home page, select the Settings icon .

2 In the System Settings page, press Expert Tools > Install Option > Import 
License

Figure 86 Enter the License code

The license file can be opened via a word processing software such as 
Word...

The challenge code must be entered exactly as it is in the .lic file, pay-
ing attention to the lower-case and upper-case letters etc.

CAUTION

Any file linked to the license file (.lic) must be saved at the root of the USB 
key.
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If the USB memory stick is not already connected to the Platform, a message 
asking the memory stick insertion is displayed. Confirm it once the stick is 
connected.

3 In the File Explorer, select the USB stick, then the license file (.lic) to be imported,

4 Click on Load > Confirm

5 The challenge codes contained in this file will then be loaded automatically and 
your software options will be installed.

6 At the end of this sequence you will be asked to reboot the unit to apply the modi-
fications, pushing the key . 

7 Confirm the reboot 

Locking the SmartOTDR
The SmartOTDR can be locked at any time:

1 In the HOME page, select the Settings icon .

2 In the System Settings page, click on Expert Tools > Instrument Lock.

3 Confirm the SmartOTDR locking by clicking on Confirm (or use the Cancel key 
to cancel the process).

The numeric keypad is displayed

4 Enter the password to lock the instrument: 42000 with the numeric keypad 
displayed.

Figure 87 License imported
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5 Click on Enter

The SmartOTDR locking screen is displayed.

Click on the Notepad Message key to add a message using the text edition.

Unlocking the SmartOTDR

1 Once the locking screen is displayed, click on the key Unlock Instrument.

2 Press confirm to confirm the Platform must be unlocked.

Figure 88 Password

Figure 89 Locking screen



Chapter 11 Maintenance and Troubleshooting
Recycling Information

User Manual 7SMART102 Rev004 147

3 Enter the password 42000 using the numeric keypad displayed and validate.

The screen automatically displays the HOME page.

Returning an instrument
When returning an instrument, it is essential to indicate the following minimum informa-
tion:

• the type and serial number of the instrument (on the identification label) and the 
configuration code (under the bar code)

• a description of the fault found on the instrument.

The returned instrument will then be repaired and calibrated.

Guarantee conditions
Any repair operation supervening within the guarantee period of the instrument will be 
carried out at the expense of Viavi. However, for any sub-assembly upon which work has 
been carried out otherwise than by Viavi Service Centers, the cost of a replacement sub-
assembly will be invoiced.

Recycling Information
Viavi recommends that customers dispose of their instruments and peripherals in an 
environmentally sound manner. Potential methods include reuse of parts or whole prod-
ucts and recycling of products components, and/or materials.

Waste Electrical and electronic Equipment 
(WEEE) Directive

In the European Union, this label indicates that this product should not 
be disposed of with household waste. Il should be deposited at an appro-
priate facility to enable recovery and recycling.
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Troubleshooting

Interpreting alarms

Troubleshooting Solution

Nothing happens when the ON/OFF 
key is pressed.

- Make sure that the battery is present or charged; 
or the mains adapter is properly connected (see 
“Connecting the mains adapter” on page 15).

Nothing happens on screen, what-
ever is the action done (menu key / 
hard key pressed...)

- The Platform must be rebooted.
See “Resetting the SmartOTDR” on page 18.

Nothing happens on touchscreen, 
whatever is key pressed (icon, 
menu key...)

- Perform an Autotune. See “Touchscreen calibra-
tion («Autotune» process for capacitive touch-
screen)” on page 150). 

You are using the SmartOTDR in 
the ordinary way when it suddenly 
switches off.

- Check the instrument is not configured to Auto off.
See “Defining the Automatic shutdown and the type 
of batteries” on page 24). 
- Check the battery charge level.
See “Charging the battery” on page 15.

The battery refuses to charge (the 
Charge indicator does not go on 
when the instrument is connected to 
the mains and is not operating).

- There is no battery in the instrument.
- The temperature level of the equipment does not 
allow the battery charging for safety reasons. Wait 
the equipment cools down.
- The battery needs to be changed.
See “Changing the battery” on page 151.

Error message when USB has been 
disconnected

- The USB disconnection has not been done prop-
erly (see “USB memory stick disconnection” on 
page 114)
- The data transfer was not completed when USB 
key was disconnected.

No beep is emitted when the USB 
memory stick is connected

- A previous USB memory stick has not been prop-
erly disconnected (see “USB memory stick discon-
nection” on page 114).
- The USB memory stick is not detected by the 
SmartOTDR: use another memory stick, or another 
storage media.
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Formatting the USB memory stick onto the 
SmartOTDR

If the USB icon  is displayed on the upper banner of the screen, when a USB 
memory stick is connected to the SmartOTDR, this may means the memory stick must 
be formatted.

If the stick needs to be formatted, proceed as follows:

1 Insert the memory stick into one of the USB port on the top of the SmartOTDR.

2 Press the HOME button

3 Validate the Settings icon to open the System Settings page.

4 On the right menu keys, successively select Expert tools > Media utilities > 
Usbflash Format.

5 Confirm your choice to actually format the USB memory stick.

Erase disk
To delete all the disk contents of the SmartOTDR:

1 On the Home page, press the Settings icon to open the System Settings page

2 Press Expert Tools > Media Utilities, 

3 Select Disk Erase to delete all the disk contents into the SmartOTDR.

A confirmation must be validated before the deletion.

4 Enter the password 02468753 and press Enter to start disk erasing.

Error message when upgrade via 
Ethernet is confirmed

- Check the Server Name is correctly entered (see 
“Installation from another server” on page 138)

Error message when upgrade via 
USB key is confirmed

Check the USB key is correctly connected (see 
“USB memory stick connection” on page 114)

Error message when unlocking the 
instrument

- The password is not the correct one (see “Locking 
the SmartOTDR” on page 145).

Troubleshooting Solution

As for any media formatting, please note that all data present on the 
USB memory stick will be irremediably lost.
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Touchscreen calibration («Autotune» process for 
capacitive touchscreen)

In case of problem with the capacitive touchscreen of your SmartOTDR, an «Autotune» 
can be performed:

From the Home page:

1 Press Settings icon top open the System Settings screen

or 

If the use of the touchscreen is not possible, press simultaneously 
the up and down arrow keys on the Platform to open the System 
Settings screen.

2 Press again the up and down arrow keys simultaneously.

A dialog box displays, asking if you wish to perform an Autotune.

3 Press Confirm to start Autotune process.

A dialog box displays during the process.

Once the dialog box is closed, the Autotune process is completed, and the screen 
is calibrated.

Figure 90 Autotune process

NOTE

Do not touch the product during the Autotune process!
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Changing the battery
If you meet problems during the Platform functioning, or if the battery does not charge 
anymore when plugged, this may require the battery to be replaced.

Accessing to the damaged battery
To access the battery of the SmartOTDR, proceed as follows:

1 Switch off the instrument and disconnect the mains supply.

2 Turn the instrument face down on the work surface.

3 Remove the battery door

4 Pull the battery connector from its housing, to disconnect it from the base, taking 
care not to damage the connector into which it is plugged.

Installing a new battery
1 Set the battery into the Platform

CAUTION

Battery is not interchangeable in the field. It must be replaced exclu-
sively for maintenance purpose.

Figure 91 Battery location

 Battery 
door

Battery

Date and Time parameters will be lost when battery is disconnected.
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2 Connect the new battery in the connector of the SmartOTDR, in the right way 
using the location notch.

3 Close the battery door

The instrument can be restarted.

Contact Viavi local Sales Service to get a new battery.

Figure 92 Setting a new battery

NOTE

Take care to set the connector of the battery in the right way on the plug of 
the base!

Do not forget the black foam to wedge the battery.

When putting a battery back into its seating, make sure that its con-
nector engages correctly with the one of the base and that the door is 
correctly closed.

Do not use any battery other than the one supplied with the instru-
ment, or supplied by Viavi.
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Accessing to the AA dry battery pack
If the battery pack is used, it can be changed.

1 Repeat step 1 to step 3 to access the battery pack.

2 Remove the battery pack removing the entire plate from its housing.

3 Change the batteries.

4 Put back the pack into the SmartOTDR.

5 Close the battery door.

The instrument can be restarted.

General information on warranty
The warranties described herein shall apply to all commercially available Viavi products. 
Any additional or different warranties shall apply only if agreed to by Viavi in writing. 
These warranties are not transferable without the express written consent of Viavi. 

Figure 93 AA dry battery pack

NOTE

The type of battery used into the AA battery pack is specified in the System 
Settings page (see “Type of batteries” on page 25)
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Hardware Warranty
Viavi warrants that Hardware Product sold to customer shall, under normal use and 
service, be free from defects in materials and workmanship. Information regarding the 
specific warranty period for this product can be obtained by contacting your local Viavi 
Customer Service Representative, or at our web site www.viavisolutions.com. If 
installation services have been ordered, the warranty period shall begin on the earlier of 
(1) completion of installation, or (2) thirty (30) days after shipment to customer. If Instal-
lation Services have not been ordered, the warranty period shall begin upon shipment 
to Customer. Hereafter these periods of time shall be collectively referred to as the Initial 
Warranty Period.

Viavi ’s obligation and customer’s sole remedy under this Hardware Warranty is limited 
to the repair or replacement, at Acterna’s option, of the defective product. Viavi shall 
have no obligation to remedy any such defect if it can be shown: (a) that the Product was 
altered, repaired, or reworked by any party other than Viavi without Viavi’s written 
consent; (b) that such defects were the result of customer’s improper storage, mishan-
dling, abuse, or misuse of Product; (c) that such defects were the result of customer’s 
use of Product in conjunction with equipment electronically or mechanically incompatible 
or of an inferior quality; or (d) that the defect was the result of damage by fire, explosion, 
power failure, or any act of nature.

Viavi performed repairs shall be warranted from defective material and workmanship for 
a period of ninety (90) days, or until the end of the Initial Warranty Period, whichever is 
longer. Risk of loss or damage to Product returned to Viavi for repair or replacement shall 
be borne by customer until delivery to Viavi.

Upon delivery of such product, Viavi shall assume the risk of loss or damage until that 
time that the product being repaired or replaced is returned and delivered to customer. 
Customer shall pay all transportation costs for equipment or software shipped to Viavi 
for repair or replacement. Viavi shall pay all transportation costs associated with 
returning repaired or replaced product to customer.

Warranty disclaimer
For hardware and/or services furnished by Viavi, the foregoing warranties are in lieu of 
all other warrantees and conditions, express or implied. Viavi specifically disclaims all 
other warranties, either express or implied, on any hardware, documentation or services 
including but not limited to warranties relating to quality, performance, noninfringement, 
merchantability or fitness for a particular purpose, as well as those arising from any 
course of dealing, usage or trade practice. 
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Under no circumstances will Viavi be liable for any indirect or consequential damages 
related to breach of this warranty.
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